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__________About This Digital Video Editing___________ 

All materials produced by the Institute are structured in the same way, as outlined below. 

How this Digital Video Editing is structured 

The Course Overview 

The purpose of this overview is to provide you with a general introduction to this course and it will help you to 

understand: 

 If the course is suitable for you 

 What you can expect from this course 

 Study skills you will need 

 Where to go for help 

 Course assignments  

 

The Course Content 

The course is divided into units, each comprising : 

 An introduction to the unit  

 Unit outcomes 

 New terminologies 

 Core content of the unit with various  learning activities 

 A unit summary 

 Assignments 

Resources 
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                                 Course Overview_________________ 

Welcome to Digital Video Editing. 

This course is designed to familiarize you with digital video editing as a tool of advanced video production.  Both 

the beginners and seasoned users can benefit from this course: starting with the basics of the course, including 

navigation and continuing with more advanced features.  

__________________________________________________________________________________________ 

 

Is this course for you? 
This course is intended for learners who have an interest in video editing. This course will give an insight for 

those who do not have any knowledge and experience in the editing field but are keen to learn editing. It covers 

all the essential features of video editing software. We encourage you to use these units as a guideline to 

experiment with different functions. To get the most out of these units start from the first unit and follow 

diligently through the units.  

 

__________________________________________________________________________________________ 

Course Outcomes 
Upon completion of this digital video editing course you will be able to know: 

• How you can edit the clips to make a final video. 

• The image presentation using different video and sound effects. 

• How to manage your old images/ videos. 

• About the stop motion animation videos. 

 

__________________________________________________________________________________________ 

Timeframe 
• 3 Months - Practical (70%) and Theory (30%) 

• Minimum 8 hours of study per week. 

______________________________________________________________________ 

Study Skills 

As an adult learner your approach to learning will be different from your school days: you will choose what you 

want to study, you will have professional and/or personal motivation for doing so and you will most likely 

dovetail your study activities with other professional or domestic responsibilities. 

 

Essentially, you will be taking control of your learning environment. As a consequence, you will need to consider 

performance issues related to time management, goal setting, stress management, etc. Perhaps you will also need 

to reacquaint yourself with areas such as essay planning, coping with exams and using the web as a learning 

resource. 

 

Your most significant considerations will be time and space, i.e. the time you dedicate to your learning and the 

environment in which you engage in that learning. 

 

 

Assignments 

 There are 10 units in this course and each unit has a few assignments for you to complete. 
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Unit 1 
============================================================ 

Introduction to Video Production 

 

   

 

 

 

Introduction 

Today's world is media-driven. People are bombarded with visual simulations everywhere. Switch on the 

TV,  view a movie, browse the Internet, scan billboards and information outlets at the malls or railway 

stations. Video editing is both an artistic and technical process. In this process video material (footage) is 

collected, compiled and changed from its original form to create a new version. The artistic process 

consists of choosing which parts to keep, delete, or combine from various sources. This ensures that the 

parts are organized, logical, and visually pleasing. The technical process consists of copying the various 

parts onto a single video tape (or CD-Rom or other media) for final viewing or distribution.  

Shooting and editing video is fun and easy. With today‘s technology, you can make compelling videos 

and films.  The production process refers to the stages (phases) required to complete a media product, 

from the idea to the final master copy. The process can apply to any type of media production including 

film, video, television and audio recording. The stages in each medium vary.   For example, there is 

obviously no storyboard in an audio recording. However the same general concepts work for any 

medium. Making a film takes time for preparation and also involves hundreds of people, but all films start 

with a moment of inspiration. 

This unit will cover the basics of video editing. You will learn the different types of video editing, video 

standards and the different stages of the video making process. Learning the video terminologies and 

broadcasts will help in understanding the video editing process.  

 

Learning Objectives  

After  completion of this unit you will be able to: 

 Plan the different stages of the digital video production workflow. 

 Design a film making and editing process. 

 Explain different types of video editing. 

 Distinguish between analog and digital editing. 

 

 

 

Watch this introductory video on video production at 

goo.gl/mJv4Cx 

https://goo.gl/mJv4Cx
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1.1   Main Stages of Production 
There are three stages of video/film production and we will discuss each of these stages below: 

Pre-production  

In this first phase of production, we have to finish script/agreement about what is to be filmed.  People are 

organized into different departments. Each department analyses exactly what is required to create the film 

(camera, sound, graphic/animation, artists, etc.),  covers all planning, scripting, storyboard, research and 

extensive  preparation before the shooting. 

In the pre production phase the production budget is very important.   It determines how much money will 

be spent on the entire film project and  involves the identification and estimation of cost items for each 

phase of filmmaking (development, pre-production, production, post-production and distribution). 

The budget structure is normally split into "above-the-line" (creative) and "below-the-line" (technical) 

costs. 

Production 
In film and video, production refers to the part of the process in which footage is recorded. This is what 

most people imagine when they think of a film being made - actors, cameras rolling, sound, action on the 

set, etc. Filming from the first to the last day of completion of the shooting/recording video includes 

sounds and images to convey an idea. 

Post-production 
Post-production is where you organize and assemble your production footage, putting scenes in proper 

order, selecting the best takes, and eliminating unnecessary elements. Production sound is synchronized 

(with the picture), edited, sometimes rerecorded, and mixed.  Music is composed and added. The footage 

is colour-corrected and special effects are created. The final movie is output to tape, film, or any other 

high quality media format. 

 

There are many things which can happen in post-production. Common tasks include editing video 

footage, editing the soundtrack, adding sound effects, music, etc. Other tasks involve adding titles and 

graphics, colour and exposure correction, adding special effects, voice-over, etc. 

 

Post-production is complete when all final decisions regarding the picture, audio, titles and graphics have 

been determined. Everything between the production, editing and up to  the final master copy, can be 

termed as digital video, film print, digital files on the web which are  ready to be seen by the audience. 

 

Film and  video editing is a purely mechanical  term.   Editing is the joining of two shots or scenes 

recorded on photographic film, videotape or the magnetic disc  physically in case of film and by electrical 

means in case of videotape and disc. This aspect of editing can also be described as the moment of change 

from one shot to another, the manner in which such a change is made, the speed of change, the order of 

shots and their duration and combining action that was shot at different times and places.  

The craft of editing is to ensure that the two shots or scenes joined together yield a meaning that is not 

apparent from them individually. This aspect of editing is also concerned with a smooth flowing picture 

development, eliminating irrelevant and distracting  portions of the recorded  images, shortening or 

lengthening the duration of action and bridging space and time.  
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The art of editing occurs when the coordination of two or more shots or scenes takes the meaning to the 

next level: excitement, emotion, shock or suspense. In other words, this aspect of editing has a direct 

impact on how the audience interprets or reacts to the screen presentation.  

Notwithstanding the fact that editing of sound too has creative possibilities, film and television mediums 

are identified mainly with their visual character.  

The editor's primary role takes place in the post-production phase. Dialogues, music and special effects 

are added in this phase.    Apart from shortening the film, the editor must work closely with the director. 

The specific goals of the editor are to find narrative continuity for the visuals and the sound of the film 

and to distil those visuals.  Sound will create dynamic emphasis to make the film effective. By choosing a 

particular juxtaposition of shots or scenes, the editor layers that narrative with metaphors and subtext as 

well as considers various meaningful possibilities of their representation.  

The editor enters  the picture once production has begun, making a rough assembly of shots while the film 

is in production. In this way adjustment or additional shots can be undertaken during the production phase 

thus minimizing unnecessary expenditure and  waste of time or recording a required shot or scene at a 

later date.  

The editor is successful when the audience enjoys the story and forgets about the juxtaposition of shots.  

1.2  What is Video Editing? 
  

 

 

 

 

Video editing is the process of manipulating and rearranging video or audio clips to create a new work. It 

also involves creating transitions between clips, colour correction, filters and other enhancements. There 

are many reasons to edit a video depending on the outcome.   A few reasons are  to remove unwanted 

footage;  choose the best footage; create a flow; add effects, graphics, music, alter the style, pace or 

mood.  

Many people use the term editing to describe all their post-production work, especially in non-

professional situations. In this unit we are reasonably liberal with our terminology and we use the 

word editing to mean any of the following: 

 Rearranging, adding and/or removing sections of video clips and/or audio clips. 

 Applying a colour correction, filters and other enhancements. 

 Creating transitions between clips. 

So why do we need to edit a video? 

There are many reasons to edit a video. Your editing approach will depend on the desired outcome. 

Before you begin you must clearly define your editing goals, which could include any of the following: 

 

Watch this video on video editing at  goo.gl/Va8y5v 

 

https://goo.gl/Va8y5v
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Remove Unwanted Footage 

This is the simplest and most common task in editing.  Many videos can be dramatically improved by 

simply getting rid of the flawed clips or unwanted shots. 

Choose the Best Footage 

It is common to shoot more footage than you actually need and choose only the best material for the final 

edit. Often you will shoot several versions (takes) of a shot and choose the best one while editing. 

Create a Flow 

Most videos are prepared to serve a purpose, such as telling a story or providing information. Editing is a 

crucial step in ensuring that  the video flows in a way which achieves the goal. 

Add Special Effects,  Graphics, Music, etc. 

This is often the "wow" part of editing. You can improve most videos (have a lot of fun) by adding extra 

elements like special effects, graphics/animations, suitable music etc. 

Alter the Style,  Pace or Mood of the Video 

A competent editor will be able to create subtle mood prompts in a video. Techniques such as mood 

music and visual effects can influence the target audience.  

Give the Video a Particular "Angle" 

Video can be tailored to support a particular viewpoint to impart the message or serve an agenda. 

1.3  Analog and Digital Video 

Editing is the process of selecting sections of video (called video clips or shots) and putting them in a new 

order on a blank tape. It can be done manually (Analog) or digitally.  

Analog Video  

Video that exists on videotape such as VHS (Video Home System), 3/4" (U-matic), S-VHS (Super VHS), 

Beta-SP, (Betacam SP), Hi8 formats, is called analog video.  It is so because the signal is similar to the 

original information. Though it seems like the best way to represent video information, it causes 

generation loss. 

Generation loss is the signet degradation caused by successive recordings. Freshly recorded material is 

first generation; one re-recording or copy, makes the second generation. Each time a copy is made, a 

certain amount of noise or graininess is added into the Image. In audio tape, it is called  hiss. The analog 

video data that is stored in the Hi-8 tapes will degrade over time due to wear and tear.  

The loss in audio or video quality results from making a copy (or "dub") in traditional analog recording 

media (audio or video "tape").  

In analog editing, you must put the shots down in the order that you want them to appear. Analog video 

records 30 individual still images on tape each second. Playing those images back in succession helps 

create the illusion of movement.  
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Digital Video 

Digital video uses binary numbers such as '0's and 1's to represent each pixel of each frame. It transfers 

data between tapes perfectly, with no generation loss. It requires at least an 8-bit representation for each 

pixel in each frame of a video. The amount of data needed for moving such a video is incredibly large. 

For this reason, computer and transmission equipment must be able to handle and transmit excessive  

amounts of data per second. The amount of data the transmission equipment can handle is referred to as 

bandwidth. DV, MiniDV and Digital8 are all digital formats of video.  

For digital devices, the bandwidth is usually expressed in bits per second (bps) or bytes per second. For 

analog devices, the bandwidth is expressed in cycles per second, or Hertz (Hz).  

In digital editing, you can put the shots down in any order, and then move them around if you decide you 

want to put them in another spot.  

Analog or digital video can be further classified as interlaced or non-interlaced (progressive scan) video.  

Interlaced Video  

Video programs using the NTSC, PAL and SECAM standards are interlaced. In this, each frame consists 

of two fields displayed in two passes.  

In interlaced video, a frame is divided into two fields. Each field contains every other horizontal line in 

the frame. A TV displays the first field of alternating lines over the entire screen, and then displays the 

second field, to fill in the alternating gaps left by the first field. The field that contains the topmost scan 

line in the frame is called the upper field, and the other field is called the lower field. When playing back 

or exporting to interlaced video, you have to ensure the field order specified matches  the receiving 

system. Otherwise, motion may appear stuttered, and edges of objects in the frame may break up with a 

comb-like appearance. Interlacing is a characteristic of capturing and displaying clips, but not a structural 

component of file formats or media. For example, it is possible to play back a digitized NTSC movie 

(interlaced) on a Mac OS or Windows monitor (progressive scan), or display a scanned 35mm film frame 

(progressive scan) on an NTSC video monitor (interlaced). 

When you diagnose problems related to interlaced fields, view the clips on an interlaced television 

display, because diagnosing field problems on a progressive-scan monitor is unreliable. If you use  

progressive-scan source clips (such as motion-picture film or computer animation), in a program intended 

for an interlaced medium such as television, you can separate frames into fields using a process known as 

field rendering so that motion and effects are properly interlaced.  

Non-Interlaced or Progressive-Scan Video 

Most personal computer displays use progressive scans. In this, all lines in a frame are displayed in one 

pass from top to bottom, before the next frame appears. Progressive-scan video gives better final picture 

quality, when editing with filters and effects that affect motion.  It is  also helpful when rotating a frame, 

or compositing live action video with special effects. In addition, thin lines and small text are more likely 

to flicker on an interlaced display.  

If you plan to slow down or hold a frame in a clip, you will want to prevent flickering or visual stuttering 

by de-interlacing its frames, which converts the interlaced fields into complete frames.  
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1.4   Categories of Editing (Lenear and  Non-Lenear) 

Editing systems fall into two categories:  the old linear suites consisting of vast arrays of complex and 

temperamental machinery; and non-linear suites, consisting of a computer and a few input devices.  

Linear Editing 

A linear suite at its most basic level is a video player and a video recorder. The first holds your original 

footage, and the second contains the program you are constructing. To edit, you can scan through the 

footage to find the shot you want, copy it onto the recorder machine, then move on to the next shot.  

If you choose this, you have to work consecutively - you can't go back and shorten your scene, or cut out 

a shot. You have to finish the first scene before starting work on the second, however inconvenient that 

may  be. 

This method of editing is called ―Linear‖ because it is done in a linear fashion, i.e. starting with the first 

shot and working through to the last shot. It is often used to mean analog editing, because in digital 

editing it is both unnecessary and difficult. It is also known as assembly editing.  

 

Fig 1:Simple Linear Editing Configuration 

Non-Linear Editing 

Non-Linear Editing (NLE) is a random–access editing of video and  audio on a computer, enabling edits 

at any point in the timeline. 

Non-linear editing requires a computer, a capture card and the right software. On a computer (non-linear) 

suite, all your footage is on disk and is accessible at any time (no constant winding through tapes to find 

it). When you construct your film, you drag clips from your disc onto a timeline. You can then move 

these clips around, alter them, lengthen and shorten them, add effects, or separate the video and sound 

without changing what is on the disk.  

The result is that you don't have to work sequentially - you can throw together an opening scene, add 

something from the middle of the film, then go back to fine-tune your first shot later on. It frees you 

creatively and enables you to work in your own way and at your own pace. You can easily assemble the 

key points in your film, and then work the rest in around them. 
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Non-linear editing has to be digital (computers don't do analog) and it is often used just to mean digital 

video.  It is called non-linear editing because you are not constrained to start  at the beginning and finish 

at the end, as you generally do with linear editing.  

 

Fig 2: Non-Linear Editing Setup 

Video editing is related only to the video. There are many softwares that are used for video editing. Video 

takes up a lot of bandwidth. It requires a fast hardware to handle it, and big hard drives to store. This Is 

especially true when digitizing analog video or capturing uncompressed digital video. If storage space is 

limited, capture a lower-quality version of the footage to perform edits.  

There are two types of video editing, on-line and off-line editing. 

On-line Editing 

In some situations multiple cameras and other video sources are routed through a central mixing console 

and edited in real time. Live television coverage is an example of LIVE/ On-line editing. LIVE or online 

is a fairly specialized job  compared to off-line editing. 

On-line editing is the practice of doing all kinds of editing on the same computer that will produce the 

final cut in the live situation. With high-end computers, on-line editing is practical for broadcast 

television or motion-picture film productions.  

Off-line Editing 

In off-line editing, we edit video using lower-quality copies of the original clips and produce the final 

version on a high-end system. Off-line editing was developed to save money by editing in a less 

expensive facility. Although off-line editing can be as simple as writing down time points for scenes 

while watching them on a VCR, it is increasingly done using personal computers and Premiere.  

Once we have completed the off-line edit in Premiere, we create a table of scene sequences called an EDL 

(Edit Decision List). We then move the EDL to an edit controller on a high-end system, which applies the 

sequence worked out in Premiere to the original high quality clips, In this way, the editing work done on 

the less expensive workstation is used to create the final cut on the more expensive, higher-quality 

workstation.  

When we digitize video for off-line editing, we specify settings that emphasize editing speed over picture 

quality. In most cases,  we need only enough quality to identify the correct beginning and ending frames 

for each scene.  
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Since we will be generating an EDL from our edits, we have to be sure all clips are captured with frame-

accurate timecode that corresponds exactly to the timecode of the high-quality source video that we will 

be using for the final on-line edit. If we plan to edit off-line, by using VHS dubs (copies) of the source 

clips, we have to be sure that in each dub we burn in the timecode and make the timecode visible in a 

window in the picture. These steps ensure that the EDL we generate is usable when transferred to the 

online system or edit bay and that our edits will be frame-accurate.  

Off-line editing techniques can be useful even if our computer can handle editing at the quality of our 

final cut. By batch-capturing video using low-quality settings, we can edit them faster, using smaller files. 

When we are ready to create the final cut, we can re-digitize the video at the final quality settings. 

 

_____________________________________________________________ 

Unit Summary 

In this unit you would have learnt several facts about the stages of post-production, editing and its 

importance. 

You were introduced to different types of editing and their role in video/film. We also studied the usage 

of video editing for making   effective film/video. The different types of video editing include linear and 

non-linear editing, analog and digital.  

____________________________________________________________ 

Assignment 

Explain the different forms of editing you have learnt in this unit.  

 What is video editing and why do we need to edit the film? 

 What are the different stages of production? 

__________________________________________________________________________________________________ 

Terminology 

IDEA:   Idea is a seed of any program. 

 FILM:   It is a  celluloid format of recording the motion pictures. 

 VIDEO:  A tape/chip  based recording format of motion pictures. 

 SCRIPT:  A screenplay or script is a written work by screenwriters for a film/video. 

 STORYBOARD: A sequence of drawings, typically with some directions and dialogue, 

 representing the shots planned for a film or television production. 

 SHOOT:  The act which is recorded  on camera called shooting. 

 PRODUCTION: The process of film making (recording). 

 EDITING:  The process of selecting, arranging and modifying video, sound, images  

of other media in a sequence. 
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Unit 2 
============================================================ 

Introduction to Streaming and Editing 
 

Introduction 
Before you begin editing, you need to decide what video format you will use to capture, edit, and for 

output. The format you choose determines your post-production workflow. 

Learning Objectives 
After completion of this unit you will be able to: 

 Understand the different video formats. 

 Learn about the  video broadcast standards. 

 Work on video dimensions and scanning methods. 

 Know about different streaming  video technologies. 

 

2.1  Video Standards and Terminology 

Video Standards  
Video technology in itself is a multimedia as it combines both visual and aural information. The seamless 

integration of computers and video represents the most difficult aspect of multimedia from the technology 

viewpoint and most rewarding from the communication viewpoint. Most communication experts feel 

digital video holds the real key to multimedia's ultimate success. Television is associated with the power 

to record, edit or view programming according to one‘s own need and schedules. Actually speaking, 

multimedia promises expanding video paradigms till interactive television becomes a reality. Video 

technology is so close to television that a slight  perspective on the latter would be appropriate. What do 

you think video is? Well, it is a sequence of individual images projected on a screen before the viewers. 

These individual images are called frames. When several frames are projected within a span of one 

second, an illusion of a motion picture is created. This is because our brain cannot register these 

individual images within a short span of time. Now that would be the frame rate for the motion picture to 

appear continuous and smooth. Actually speaking, the frame rate typically ranges from 24 to 30 fps 

(frames per sec).  Also, one or more audio tracks are synchronized to the video camera to give sound 

effects to the motion.  

Different countries use different types of television broadcast systems, video, audio and channel systems. 

Most of these systems are incompatible with each other. Converting between some formats can be simple, 

while converting between other formats can be difficult. The following are the five main types of video 

standards accepted throughout the world:  

 NTSC—National Television Standards Committee (NTSC), standard for colour TV transmission was 

introduced in 1954 as the first set of standard protocols for television. It is used all over the USA, Canada, 

Japan and elsewhere. NTSC has 525 lines displayed at 30 (29.97) frames per second. it has a lower 

resolution than PAL or SECAM but a faster frame rate, which reduces flicker.  

 

 PAL-Phase Alternating Line (PAL) was developed by Walter Bruch at Telefunken (Germany). It is 

used in Western Europe, Asia, throughout the Pacific, South America and Southern Africa. PAL has a 

higher resolution than NTSC with 625 lines, but it runs at 25 frames per second. There are two variations 

that have been developed: PAL-M and PAL-N. The only country using this standard is Brazil. The main 

difference between PAL-M and PAL- N is a lower resolution (525 lines instead of 625) and a higher 
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frame count (30 frames per second at 60Hz versus 25 frames per second at 50Hz). PAL-M grew out of 

NTSC as an attempt to correct the colour problems of NTSC. PAL-N is another variation that is only used 

in Argentina and Uruguay. Differences here include the sub-carrier frequency. 

 

 SECAM- System Electronique Couleur Avec Memoire (SECAM) was developed in France out of 

PAL and was adopted in 1967. It is used in France, other territories, CIS, much of Eastern Europe, the 

Middle East and Northern Africa. This system uses the same resolution of PAL, 625 lines, and frame rate, 

25 per second, but it is not compatible with PAL. There are three varieties of SECAM: French SECAM 

used in France and its former territories, ME-SECAM which is used primarily in the Middle East and 

North Africa and D-SECAM which is used mainly  in the CIS, and the former Eastern Bloc countries.  

 

 HDTV - High Definition Television (HDTV) is part of Advanced TV, or AN. This is a new digital 

television technology that provides picture quality similar to 35 mm movies with sound quality similar to 

today's compact disc. The HDTV technology exists and some television stations have begun transmitting 

to users on limited channels now uses digital rather than analog signal transmission, utilizing the MPEG-2 

and MPEG-4 file format and compression standard. HDTV is also a standard that is becoming available 

on cable and satellite TV.  

 

The point of this discussion is to emphasize that productions intended for other parts of the world or 

footage coming from other parts of the world must undergo standard conversion. The equipment required 

to convert between video standards is too intricate and expensive for the average production facility to 

purchase.  

 

 DV-Digital Video (DV) format appeared in the  late 1900s when a new generation of entirely digital 

cameras and camcorders emerged. The DV compression format is used for DV and Digital-8 camcorders. 

DV format video and audio can be captured using a FireWire / IEEE 1394 interface and then saved and 

edited in a video edit suite. The consumer tape format is more accurately called mini-DV.  

 

The DV cassette is a small, metal-oxide tape, about three-quarters the size of a DAT. It allows the entire 

video processing cycle to remain within the digital domain. It does not follow analog-to-digital 

conversion by a traditional video capture card. DV footage - already in a compressed digital format - can 

be downloaded to a PC in real-time with no loss of quality.  

Video Terminology  

There are a few terms that you must know before learning about video editing. These terms will help you 

to understand the terms used in editing.  

 Frames  

A frame is one complete image in a moving sequence of images. In video, the frame captures and displays 

all pixels and lines of an image. Video formats and individual clips are described in terms of the 

resolution of the individual frames, and the frame rate at which they are played.  

 

 Frame Size  

The size of a video that appears on screen is called frame size. Capture each frame at high resolution to 

add more resolution to a video. High resolution requires more hard disc space and processing power to 

playback smoothly. 

 

 

 



 Page 20 
 

 Frame Rate - fps:  

The frame rate determines how many single images get displayed over the duration of one second. it is 

measured in frames  per second (fps). Higher frame rate means smoother motion during playback. More 

memory is required to store and playback the video each time. The frame rate of a progressive scan 

format is twice that of an interlace scan format.  

 

 Aspect Ratio  

Aspect ratio is the width-to-height ratio of an image or frame. Widescreen film uses a 16:9 aspect ratio 

(1.78:1); standard television uses 4:3 aspect ratio (1.33:1). A DVD disc can store video in either standard 

or widescreen format.  

 

 SMPTE   

The Society of Motion Pictures and Television Engineers (SMPTE) is a special organization that sets 

technical standards for film and video. It is a form of time code developed by that same organization. It is 

also known as Longitudinal Time Code and  is a high frequency signal that allows the accurate ―locking" 

of film audio and video equipment. Locator information is displayed as numbers.  

 

 Time Code  

Time code is an exact time used to identify a specific frame in a clip or production. It is measured in 

hours, minutes, seconds, and frames.  

 

 Feet/Frames 
 Feet/Frames are the footage numbers for film. They are either separated by a colon or by a "plus‖ sign. 

For example, 101:16 and 0101+16 both indicate a point 101 feet and 16 frames into the film. There are 16 

frames per foot of 35mm film, and 40 frames per foot of 16mm film.  

2.2  Video Standard Formats 

Most video broadcast formats are described by the following characteristics: 

 Image dimensions and aspect ratio 

 Frame rate 

 Scanning method 

 Video standards 

For the last 50 years, there have been two major signal types recorded on videotape: NTSC and PAL. 

With the emergence of new high definition (HD) video formats, NTSC and PAL formats are now referred 

to as standard definition (SD) video formats. 

 Image Dimensions and Aspect Ratio 

The horizontal and vertical pixel dimensions of your format determine the frame size and aspect ratio. For 

example, SD NTSC video is 720 pixels vertical and 486 pixels horizontal. HD video is either 1280 x 720 

or 1920 x 1080, and is usually referred to by the vertical dimension (for example, 720 or 1080) and the 

frame rate. In addition, the interlaced HD formats according to their field rate rather than frame rate; for 

example, 1080i60 (59.94 fields per second) rather than 1080i30 (29.97 frames per second). Digital cinema 

formats are referred to using their horizontal dimension as 2K, 3K, or 4K, shorthand for at least 2,000 

pixels, 3,000 pixels, or 4,000 pixels wide. 

The aspect ratio of a video frame is the width with respect to the height. SD video has an aspect ratio of 

4:3, while HD video uses 16:9. Digital cinema formats use the 16:9 aspect ratios as well as closely related 

film-based aspect ratios. 
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Note: You may notice that 1280/720 or 1920/1080 is equivalent to 16:9, while 720/480 is not equivalent 

to 4:3. This is because SD digital video uses pixels that are rectangular, not square. 

 Frame Rate 

The number of frames per second displayed during playback. The frame rate of your video determines 

how quickly frames are recorded and played back. The higher the number of frames per second (fps), the 

less noticeably the image flickers on screen. There are several common frame rates in use: 

• 24 fps: Film, and certain HD and SD formats, use this frame rate. This may also be 23.98 fps 

for compatibility with NTSC video. 

• 25 fps: SD PAL, HD PAL 

• 29.97 fps: SD NTSC, HD NTSC (720p30, 1080p30, and 1080i60) 

• 50 fps: 720p HD 

• 59.94 fps: 720p HD 

• 60 fps: 720p HD 

 

 Scanning Method 

Video frames are composed of individual lines, scanned from the top of the screen to the bottom. Lines 

may be scanned progressively (one line at a time), or interlaced (every other line during one scan, and 

then the alternate lines on a subsequent scan).  

 

 Standard Definition Video 

Standard Definition Television (SDTV or SD) is a television system that uses a 704×576 resolution and 

4:3 video aspect ratio of  SDTV has the same appearance as regular analog   TVNTSC  is the television 

and video standard used SDTV in most of the Americas, Taiwan, Japan, and Korea. Phase Alternating 

Line (PAL) is the television used SDTV video standard in most of Europe, Australia, India, Brazil, China, 

and many African countries. There are several variations of both NTSC and PAL used in different parts of 

the world. 

 

 

 

 

 

 

 

 

 

Fig 3: Standard Definition Video 
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 High Definition Video 

In the late 1990s, HD video formats were standardized in the United States by the Advanced Television 

Standards Committee (ATSC). These HD video formats are the next generation of broadcast and 

recording video formats. Unlike SD formats, which are restricted to fixed frame rates and numbers of 

lines per frame, HD video provides several options per format. Although the increased flexibility is 

convenient, it also makes format interchange more complicated. Simply saying ―HD video‖ is not 

enough; you need to define the frame size, frame rate, and scanning method of your HD format. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 4: High Definition Video 

2.3  Video Broadcast 
From the very earliest days of television, right up to the 1990s, all television broadcasts were made using 

analog television and it was not considered  feasible to introduce a digital system owing  to the 

complexity of the processing required. However, with the advance of digital processing techniques and 

the advances made in integrated circuit technology the possibility of using digital techniques for 

television broadcasting became a real possibility. 

Different countries use different types of broadcast TV system, most of which are to varying extents 

incompatible with each other. Unfortunately, video recordings retain many of the characteristics of the 

original signal of which they are recording. In general, recordings are more likely to be compatible than 

receiving equipment, but only with their own ―family". 

In order to work TV receivers require a source of field timing reference signals. These are signals that tell 

the TV  receiver to be prepared to receive the next picture in the stream of images. Early set designers 

decide to use the mains power supply frequency as this source for two good reasons. The first was that 

with the older types of power supply, you would get rolling hum bars on the TV picture if the mains 

supply and power source were not at exactly the same frequency. The second was that the TV studios 

would have had enormous problems with flicker on their cameras when making programs. 

There are two mains power frequencies widely used around the world, 50Hz and 60Hz. This immediately 

divided the worlds TV systems into two distinct camps, the 25 frames per second camp (50Hz) and the 30 

frames per second camp (60Hz).  

Later the 60Hz camp made a small adjustment and changed the field rate to 59.94Hz when they added 

colour to the signals. The issue of field frequency remained sufficiently deep-rooted in both TV standards 

and  the vested interest remained long after the original technical justification had gone.  
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The biggest compatibility problems between TV standards remain related to the field rate; these are also 

the hardest problems to solve.  

Beyond the initial divide between 50 and 60Hz based systems, further sub-divisions have appeared within 

both camps since the inception of colour broadcasting. The majority of 60Hz based countries use a 

technique known as NTSC originally developed in the United States by a committee called the National 

Television Standards Committee. NTSC (often scurrilously referred to as Never Twice the Same colour) 

works perfectly in a video or closed circuit environment but can create  problems of varying hue when 

used in a broadcast environment.  

This hue change problem is caused by shifts in the colour sub-carrier phase of the signal. A modified 

version of NTSC soon appeared which differed mainly in that the sub-carrier phase was reversed on each 

second line; this is known as PAL, standing for Phase Alternate Lines, it has a wide range of facetious 

acronyms including Pictures PAL has been adopted by a few 60Hz countries, most notably Brazil.  

Amongst the countries based on 50Hz systems, PAL has been the most widely adopted. PAL is not the 

only colour system in widespread use with 50Hz; the French designed a system of their own - primarily 

for political reasons to protect their domestic manufacturing companies - which is known as SECAM, 

standing for Systeme Electronique Couleur Avec Memoire. The most common facetious acronym is 

System Essentially Contrary to American Method; SECAM was widely adopted in Eastern Bloc countries 

to encourage incompatibility with Western transmissions,  again a political motive.  

In general, since the field and scan rates are identical, you can expect to get a monochrome picture from a 

PAL video recording replayed on SECAM equipment, and vice versa. Transmission frequencies and 

encoding differences make equipment incompatible from a broadcast viewpoint. Transcoders between 

PAL and SECAM, while often difficult to find, are reasonably cheap.  

In Europe, a few Direct Satellite Broadcasting services use a system called D-MAC. Its use is not 

widespread at present and it is transcoded to PAL or SECAM to permit video recording of its signals. It 

includes features for 16:9 (wide screen) aspect ratio transmissions and an eventual migration path to 

Europe's proposed HON standard. There are other MAC-based standards in use around the world 

including B-MAC in Australia and B-MAC60 on some private networks in the USA. There is also a 

second European variant called D2-MAC, which supports additional audio channels making transmitted 

signals incompatible, but not base band signals. 

 Video for Web  

With the increasing use of broadband communications and fast personal computers, the future of video 

distribution will involve the use of the Internet, and a technology known as streaming video, a technology 

ideal for sales presentations and tutorials. 

Unlike video downloads, where one can easily spend half an hour downloading a video file onto your 

hard disc, in streaming video the video content is downloaded in small chunks so that it will start playing 

almost as soon as you start downloading, and while it is playing the video it is downloading the next 

chunk. Streaming video technology thus gives virtually anyone the capability of providing an Internet-

based, on demand, video broadcast; just the thing for letting others see your latest video production, or 

providing video-based tutorials, sales presentations, etc.  

Currently the only real drawback to the technology is the limitations on communications bandwidth, the 

amount of data you can send over the phone line in a given period, means that the displayed image has a 

fairly low resolution.  
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In other words, image quality is much poorer than that obtained on a tape or optical disc copy of a video. 

However, streaming video technology, and Internet communications technology, is developing rapidly 

and the image quality problem is unlikely to persist for very long. Internet-based video on demand using 

streaming technology is used frequently. 

From the video maker's point of view, what is great about streaming video is that it does not require any 

physical distribution, and therefore allows one to distribute to a global market, with none of the problems 

of postal restrictions and tape format differences. It is also a technology, which is very cheap and as easily 

used by someone wishing to distribute a single home made video as a big company marketing dozens of 

films.  

2.4   Streaming Video Technology  

Streaming video technology is all about compressing the amount of data in a video image so that it can be 

more easily transmitted via the Internet. A film consists of a sequence of images, about 24 frames per 

second. Each image when digitized consists of hundreds of thousands of picture points, or pixels, each of 

which contains information about the colour of that pixel. Any video film in digital form thus consists of 

a sequence of millions of miniscule bits of colour information per second, and on top of this there is 

another stream of data consisting of digitized information for the soundtrack.  

To play raw digitized video in real time you would have to transfer millions of bytes of data per second 

over the Internet. Fortunately there are several facts, which can help you.  The first is that in most images 

there are large areas where the colour information is the same, and secondly the human eye is not very 

good at distinguishing a very wide range of different colours. These two facts mean that you can use a 

computer program to compress an image by removing redundant information.  

Look at any photo displayed on a web site and you will find that it is compressed to 30 or 40K bytes, 

from an original image size of several hundred, or even a couple of thousand, kilo bytes. It is this 

compression that allows an image to be downloaded in a couple of seconds rather than half a minute. 

Video though requires not just one image per second but also 24, so compression must be even greater, 

hence the necessary reduction in image size and quality.  

Fortunately, the nature of film comes to your aid in your quest for data compression. This is because the 

difference between each image is fairly small.  So all you need to transmit is the change in the image 

between one frame and the next. It is this concept of image change, which is very important if you are 

shooting and editing video with intent to distributing it online. 

Streaming video technology thus converts video film into a compressed form, which can be transmitted in 

real time over the Internet, and then decompresses the image so that it can be displayed, again in real 

time, on any computer monitor. This compression-decompression process is handled by special software 

known as Codec.  

 

2.5   The Codec  

A Codec, short for compressor de-compressor, is basically two pieces of software, one mathematically 

ompresses  video data for transmission, and the other decompresses that data into some form of display 

on the computer monitor.  

So the goal for a mathematically-based Codec is to do all this work as efficiently as possible. On the 

compression side, this usually means removing  unimportant data. Quality is the first casualty in this kind 

of process. The Codec has to make things smaller, which means shrinking display size, or reducing the 
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number of frames per second. The Codec might also cut out the fine details, or make the audio sound less 

clear.  

 

Unfortunately the result of all this data reduction can be an absolutely appalling image. However, it need 

not be, if the video is shot and edited with the requirements of the Codec firmly in mind. After all, the 

advantages of being able to distribute globally, on demand, make such considerations  worthwhile.  

What you have to remember is that all the Codecs used to create streaming media focus on change. A 

compression algorithm typically works best when there is no change in what it is trying to compress. 

Forget how you see video and think like a computer. If change happens between two frames of video, that 

change has to be represented on the screen. You have to show the change between frames to get 

movement. If no change happens, the first frame can stand in for the second. That is because the first 

frame has the same information as the second. So while you see  two frames, you only need the data for 

one. 

During encoding, a streaming media video Codec basically does just that kind of work. Areas of change 

need more information. Areas that don't change offer savings. You should also remember that most 

streaming media Codecs lose data by losing detail,  which  means that sharp edges  get blurry the more 

you compress. Sharp edges are harder to mathematically compress and maintain image quality than soft 

edges.  

 

What all this means is that if you are shooting video which will be compressed for streaming media it is 

important to keep the background as static as possible, either by having as plain a background as possible, 

or by not moving the camera, or a combination of both. Also one should try and avoid rapid actor, or 

camera movement.   Do not create sequences of short shots during editing, or make use of zooming, 

panning, or complex fades, etc. 

Progressive Streaming  

Progressive streaming is the easiest route for beginners, as it requires no special server, such as a 

streaming server. One can use a standard Web server to upload the compressed video file. Quality is 

generally better using progressive streaming than with real-time. And once you decide to play the video 

online, the whole file begins to download to your hard drive. Progressive users also can't jump ahead to 

other sections of the video.  

Depending on the format of the video (such as Real), some progressive files may require us to download 

the entire video before playing it. This creates one of those annoying "hurry up and wait" scenarios. 

Thankfully, QuickTime supports a 'faststart' feature which automatically kick-starts your video player as 

it downloads. In an age of instant gratification, this is a great feature and QuickTime is the only major 

video architecture that supports it for now. For that feature alone, QuickTime is much better suited for 

progressive streaming than Real Video or Windows Media Player.  

In general, progressive streaming works best for videos under three minutes, such as movie trailers, and 

the shorts you see on sites such as QuickTime TV, film, Atom Films, and on home video sites such as 

Share Your World.  

Real-Time Streaming  

Unlike progressive streaming, real-time streaming requires a special streaming server. This can be a 

QuickTime Streaming Server (RTSP), a Real Networks Server or a Windows Media Server.  

Video streamed for real-time plays automatically. You don't need to download the entire video before 

playing. You can jump to any location in the video clip. And the clip always resides on the server. Video 
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encoded for real-time streaming generally tries to keep pace with the user's connection speed in order to 

minimize interruptions and stalling.  

There is  nothing one can do about general Net congestion, but the streaming server at least tries to 

compensate by maintaining a constant connection.  

You will find real-time streaming is best suited for longer videos such as live event broadcasts, 

presentations, training videos and lectures-where users can move  ahead to other parts of the clip and 

don't have to download a huge video file. It also offers suitable  protection for one's creative content as 

users can't download it to their hard drives and redistribute your work. Unfortunately, the video quality is 

not as good with real-time as with progressive. But getting quality video on the Web is all about trade-

offs.  

If you are  just starting out, you might want to create a simple Web page, encode your video using a 

progressive streaming method and embed the clip into your site. Or, if you are  determined to stream the 

video, you might consider using a third party and their servers.  

______________________________________________________________ 

Unit Summary 
In this unit you have learnt about the different video formats like Standard Definition (SD) and High 

Definition (HD) and the different Broadcast Standards like NTSC, PAL, and SECAM. We also discussed 

the different frame rates, video dimensions and the scanning method. The different types of streaming 

video technologies were also explained. 

_______________________________________________________________ 

Assignment 
Give a detailed explanation of - 

 What are the different video standards? 

 What are the various broadcast standards used in the world? 

 Explain the different frame rates and video dimensions. 

 What are the two types of streaming video technology? 
 

____________________________________________________________ 

Terminology 

HDTV:     High definition television 

SDTV:    Standard definition television 

PAL:      Indian TV broadcast standard. 

NTSC:      A TV broadcast standard. 

ANALOG:     Analog video uses a signal that consists of a constantly varying voltage level. 

 

DIGITAL:     Digital video is audio/visual data in a binary format.  

   Information is a sequence of zeroes and ones. 

FPS:      Frame per second. 
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Unit 3 
============================================================ 

Start with Adobe Premier Pro 

 
Introduction 

You have learnt about the different types of video standards, video technology, and the production 

process in the previous units. In this unit you will learn about Adobe Premiere Pro and all the things that 

can be done in it.  

Adobe Premiere Pro software brings digital movie making to your desktop. It is a simple, powerful and 

professional video-editing tool. It is the editing software loved by most video professionals, covering the 

world of broadcast and online media. Adobe Premiere Pro is used in recording, creating, and playing 

video programs using video, sound, animations, photographs, drawings, text and many more material 

things on a Windows or Macintosh computer.  

Adobe Premier Pro (APP) is a non-linear video editing application that helps beginners and seasoned 

professionals achieve stunning results. In this hands-on course, learners will become familiar with the 

user interface while they learn to perform editing functions. Students work with real-world media to learn 

practical approaches to video editing from basic techniques to Adobe Premier Pro‘s powerful advanced 

features. 

Learning Objectives 

After completion of this unit you will be able to:  

 Create a new project. 

 Learn about the different windows in APP. 

 Plan on  editing  a new project. 

3.1   Know the Workspace 
Adobe Premiere Pro workspace appears when a project is open. It can be customized according to the 

style and method of working. The windows that open by default in a new project are as follows:  

 

 

Fig 5: Project Window 

Project Window 

It lets you import, organize, and store references to clips. It lists all source clips imported into a project  

and  It is not necessary to use every clip that is imported.  



 Page 28 
 

Monitor Window 

This window includes the source view on the left side and the program view on the right side in the 

default dual view mode. In single view mode the program view is displayed. Use the source view to 

review, edit, and trim an individual video clip, and the program view to see the current state of the video 

program being edited in the Timeline.  

 

Timeline Window 

This window provides a schematic view of your program, including all the video, audio, and 

superimposed video tracks. Changes you make appear in the program view.  

 

Audio Mixer Window 

Choose Window > Audio Mixer to access this window. It provides sophisticated audio mixing 

technologies that allow you to adjust multiple audio tracks while listening to them and viewing your 

video in Real-Time. You can control settings such as volume and pan/balance for, such as audio track 

from this window.  

 

The palettes are organized in separate windows. All the palettes are listed in the Window menu.  

 

Effects Palette 

This palette contains all  the video and audio transitions and effects, which can be applied to clips in the 

video or audio tracks in the Timeline window. It opens by default and can be docked with the Project 

window to save space on the desktop.  

 

Tools Palette 

This palette allows you to perform all the necessary editing to your video project .  It opens by default.  

 

Effect Control Palette 

This palette allows you to change effect settings at any time and appears when an effect or transitions has 

been applied to a clip. This palette opens when you choose Windows > Effects Controls.  

 

Info Palette 

This palette provides information about the selected clip, transitions, selected area in the Timeline, or 

operations you are performing.  

 

History Palette 

This palette lets you go back to any previous state of the project created during the current working 

session. Each time you make a change, a new state is added to the History palette. You can delete all the 

edits after the selected state, return to your current state, or incrementally restore states. 

The editing phase occurs in a project—a timeline-based container of sequentially arranged clips that tells 

a story. Projects are simple or complex timelines, depending on the technical depth of the story. 

 

 

 

 

 

 

Fig 6: History Palette 
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Projects are stored within individual events in a library; the super-container of your Adobe Premiere 

editing project that makes loading/unloading and transporting all your clips, events, and projects for a 

show, client, or movie much more convenient. 

Projects may contain as many sequences as you need. For example, a news editor may need three 

sequences for the VO (voiceover), the package, and the teaser. A documentary editor could easily use 10 

to 30 sequences when breaking down an edit by segment, creating various video news releases, posting 

online teasers, and developing diverse versions of the documentary based on running time and/or content. 

Creating a Project 
To start the editing, you must create the project first. A couple of clicks and you have  got yourself a 

starting project. Whenever we start planning for editing  a project, it is important that we should have a 

good plan write-down or proper log sheet ready for editing so that we can easily manage our project.  

Before you start editing any video you need to understand the environment. The first thing you need to 

understand is your subject and how you are going to deal with it. Your subject could be fiction, 

documentary, biopic on a personality, docu-drama, quiz, chat show, reality show, sports events, etc. 

Different subjects and formats generally have a different treatment. An  efficient  editor with a good 

aesthetics sense can bring out the best output. 

After importing and organizing, the story elements as clips in the library are ready for editing. The editing 

phase of the post-production workflow involves crafting a story from the library clips into a project or 

timeline. 

The first edit, or rough cut, of a project involves some or most of the major tasks from the remainder of 

the post workflow. An edit of the project is created; it is trimmed down for timing, pacing, and 

conciseness; additional elements such as music may be added; and then the project is shared out of 

Premiere  Pro for the client or producer‘s approval. 

A movie created using Adobe Premiere Pro  can be played in any application that supports the 

DirectShow format or the QuickTime format. It can even have the output video in different formats, 

including videotape, Edit Decision List (EDL), Advanced Authoring Format (AAF), MPEG or Animated 

GIF format. 

3.2   Working with a Project 
A project in Premiere is a file that describes a video program. A project keeps references of all the clips in 

that file. It contains information about sequences, and clips that are arranged. A project also stores 

information about any transitions, audio mixing, and effects applied. A single project can have many 

sequences. These sequences can be edited individually and nested to form a longer sequence. All the 

media projects can be organized using bins. 

Starting a New Project  

A Project in Premiere can be created by choosing presets, or customizing project settings.  

 

Step-by-step instructions to start a new project: 

A project in Premiere Pro can be created customizing project settings. Also choose custom settings tab 

when you create a new project. Do so only if none of the available presets match the specifications of 

your source media. After a project is started, you can check the project settings at any time by choosing  

Project> Project Settings 

 

 

 

 



 Page 30 
 

General Settings  

In general settings, you can see an overview of the project settings, including the editing mode, time 

display, and playback video. The following options are specified in general settings.  

 

Editing Mode 

It determines which video method is used to playback video from the timeline and which compression 

methods are listed in the Video Settings Panel. The options in the editing mode are more likely to be DV 

playback, Video for Windows and  QuickTime, which gets installed with Premiere Pro. The DV Playback 

and QuickTime options allow you to set Playback options by clicking the Playback setting button.  

 

Timebase 

It determines how Premiere Pro divides video frames each second when calculating editing precision. In 

general, select 24 for editing motion-picture film, 25 for editing PAL and SECAM video, 29.97 for 

editing NTSC video, or 30 for other video types. Timebase is not to be confused with the frame rate of the 

video that is played back, or export from the timeline, although timebase and frame rate often use the 

same value.  

 

Frame Size 

Specifies the dimensions, in pixels, for frames when you playback video from the Timeline. Make sure 

the frame size for the project matches the frame size of the footage. A larger frame size lets you to see 

more details but requires  more processing. If playback is slow, try reducing the frame size. When 

changing the frame size, keep the dimensions proportional.  

 

Pixel Aspect Ratio 

Sets the aspect ratio for individual pixels. It controls the aspect ratio of a pixel dimension, i.e. horizontal 

to vertical. The standard Video Aspect ratio is 4:3. If you change the aspect ratio of a video clip, the result 

can be a distorted image. For example, choose square pixels for analog video and images created in 

graphic programs, choose D1/DV NTSC for output to video using DV video, choose D1/DV PAL 

Widescreen 16:9 (1.422), D1/DV PAL (1.067) for output to D1/DV widescreen, choose Anamorphic 2:1 

if the video was shot on film with an anamorphic lens. 

 

Fields  

The sets of alternating horizontal lines that create an interlaced image on a TV screen. A complete TV 

frame consists of two fields. The odd-numbered lines of field one are interlaced with the even-numbered 

lines of field two.  

 

Sets which field of each frame's interlaced is drawn first. Select No Fields when you work with 

progressive-scan video. Note that many capture cards, capture fields, regardless of whether you shot 

progressive scan footage.  

 

Display Format (video)  

Sets how time appears throughout the project. The time display options match to standards for editing 

video and motion-picture film. For broadcast NTSC video, choose 30 fps Drop-Frame Timecode if that is 

the time display used by the original video. For video to be played back from the Web or CD-ROM, 

choose 30 fps Non-Drop-Frame Timecode. For PAL and SECAM video, choose 25 fps Timecode.  
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Safe Area  

Specifies the frame edge to mark as a safe zone for titles. It is done so that  titles are not cut off by 

televisions that zoom the picture slightly to enlarge it. When you click the Safe Zones button in the 

Monitor window, a rectangle with cross-hairs mark the title-safe zone. Titles are usually assumed to 

require a wider safe zone than action.  

 

Action Safe Area  

Specifies the frame edge to mark as a safe zone for action. It is done so that action is not cut off by 

televisions that zoom the picture slightly to enlarge it. When you click the Safe Zones button in the 

Monitor window, a rectangle marks the action-safe zone.  Automatically Scale Imported Media to Project 

Size - Adjusts imported video and still images so that they fit within the frame, if they are larger or 

smaller than the frame.  

 

Rate  

Higher rates, give better audio quality, when you play back audio in sequences. In doing so, they require 

more disc space and processing. Resampling, or setting a different rate from the original audio, also 

requires additional processing time and affects the quality. For that record audio at a high-quality sample 

rate, and capture audio at the rate at which it was recorded. 

 

Display Format (audio) 

Sets the audio time display. You can measure audio using audio samples or milliseconds. Display Format 

applies when Audio Units are  selected in the Monitor window menu. When you select DV Playback 

editing mode, DV video and audio use standardized settings automatically. Also when you use this mode, 

avoid changing the Time Base, Frame Size, Pixel Aspect Ratio, Fields, and Sample Rate settings. 

 

Colour Depth 

Shows the colour bit depth or number of colours to include in video played back in sequences. if the 

selected compressor provides only one option for bit depth, this button may not be available. You can also 

specify an 8-bit (256-colour) palette when preparing a video program for 8-bit colour playback, such as 

when using the video for Windows editing mode for the Web or for some presentation software.  

 

Optimize Stills 

Choose this option to use still images efficiently in sequences. For example, if a still image has a duration 

of 2 seconds in a project set to 30 fps, Adobe Premiere Pro creates one 2-second frame instead of 60 

frames at 1 '30 of a second each. Deselect this option if sequences exhibit playback problems when 

displaying still images.  

 

Default Sequence 

It determines the number of video and audio tracks for new sequences, apart from the type of audio 

tracks. A sequence in Premiere Pro can contain any combination of mono, stereo, and 5.1 surround tracks. 

Tracks can be added or deleted at any time, but the number of channels a track uses cannot be changed 

after you first create it. A sequence always contains a master track that controls the combined output for 

all tracks in the sequence. 

 A sequence of audio can contain two kinds of tracks. One is the regular audio track containing actual 

audio,another is the submix track. Submix tracks output the combined signals of tracks routed to it. They 

are useful for managing mixes and effects. Audio and submix tracks can be of mono, stereo or 1.5 

surround tracks. They are based on the number of channels in the track.  
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____________________________________________________________________________________ 

Unit Summary 

In this unit you have learnt about the opening of the software and different types of program windows and 

their uses. You were also  briefed about different window palettes used in the software.  How to create 

and work with a new project has been taught in this unit. 

____________________________________________________________________________________ 

Assignment 
Give a detailed explanation of - 

 What are the different types of windows used in Adobe Premiere Pro? 

 What are the different points you plan before starting the actual editing?  

 How can you   create a Project in the Adobe Premiere Pro? 

__________________________________________________________________________________________ 

Terminology 

 

BIN:  Bins are like folders  where you can store your media files. 

TIMEBASE:  Determines how premiere divides video frames. 

TC:  Time Code shows you where the play head is at in your project. 

TRACK HEADER: Track Header is the area to the left of the Timeline track. 

MARKERS:  Markers are used for positioning and trimming clips. 

AVI: Audio Video Interleave. The standard, uncompressed video file format on the 

Microsoft® Windows® platform. 
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Unit 4 
============================================================ 

Video Capturing 

 

 

 

 

 

 

 

Introduction 
You have learnt about the workspace of Adobe Premiere Pro‘s various windows and other features in the  

previous unit. In this unit you will know how clips are imported to your project to keep all the source 

clips available instantly from a hard disc and not from videotape when you start to editing  your video 

programme. The process of importing the source clips from the source, i.e. videotape to your computer is 

called video capture. 

After completion of this unit you will be able to: 

Learning Objectives 

 Understand the capturing process. 

 Distinguish between  Analog and  Digital media. 

 Work on offline files. 

4.1 Capturing the Video 
Remember to keep all the source clips available instantly from a hard disc and not from videotape when 

you start  editing  your video program. The process of importing the source clips from the source 

videotape to your computer is called video capture.  

 

 

 

 

 

 

 

Fig 7: Capturing the Video 

 

Watch this introductory video on video capturing at 

goo.gl/NBD3WG 

 

 



 Page 34 
 

  

Make sure you have enough storage on your hard disc to store all the clips you want to edit. To save 

space, capture the clips you already know you will use.  

Source material exists in two main forms:  

 Analog media 

 Digital media 

 

4.2 Analog Media  

Before using any analog media, digitize it. That means that it must be converted to digital form and saved 

in a digital file format before a computer can store and process it.  

 

Fig 8: Video Tape 

Source: goo.gl/hjC2pD 

Clips from analog videotape, motion-picture film, conventional audio tape and continuous-tone still 

images (such as slides) are all examples of analog media. You can digitize, compress, and transfer analog 

source material to disc as clips using Adobe Adobe Premiere Pro. For that you need to connect an analog 

device (such as an analog video camera or tape deck) and an appropriate capture card to your computer. 

The digitized clips can then be added to your digital video project.  

Capturing Analog Video 

First connect the camcorder or deck to the capture card installed in your system, when capturing analog 

video. You may have more than one format available for transferring source footage depending on your 

equipment. Refer to the instructions included with your camcorder and capture card. Most video-capture 

card software is written, so that its controls appear within the Premiere Pro interface. Though such 

provisions are made, much of the actual video processing happens on the card, outside Premiere. Most 

supported capture cards provide a preset that automatically sets up Premiere for optimal support for that 

card. You will find settings on controlling how a clip is captured from a camera or deck, in Project 

Settings > Capture dialogue box.  

Using the Movie Capture Window 

Use this window to capture DV and analog video and audio. To open this window, choose File > 

Capture. 
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This window includes:  

• Preview window that displays your currently recording video. 

• Controls for recording media with and without device control.  

• Movie capture window menu button. 

• Settings panel for viewing and editing your current capture setting.  

• Logging panel for entering batch capture settings (you can only log clips for batch capture when using 

device control).  

4.3  Digital Media 

Clips in digital format can be read and processed by a computer directly. There are many new camcorders 

available nowadays that digitize and save video in a digital format, right inside the camera. The 

camcorders use one of several DV formats. These formats, apply a standard amount of compression to the 

source material.  

 

Fig 9: Digital Storage Devices 

Audio can also be recorded digitally. Soundtracks are often provided digitally as well, such as on CD-

ROM. Digital source files stored on DV tape or other digital media must be captured to an accessible hard 

disc before they can be used in a computer for an Adobe Premiere Pro project. The simplest way to 

capture DV is to connect to a DV device, such as a camcorder or deck, to a computer with IEEE (Institute 

of Electrical and Electronic Engineers) 1394 pot/ (also known as FireWire or i.Link). For more 

sophisticated capture tasks, a specialized DV capture card might be used. Adobe Premiere Pro supports a 

wide range of DV devices and capture cards, making it easy to capture DV source files. 

Capturing DV  

While shooting, the footages are saved on a DV tape cassette. These footages are converted directly into 

digital (DV) format right inside the DV camcorder. The footages are already digitized and compressed, so 

they are ready for digital video editing. The DV footage can be transferred directly to a hard disc. Now 

you need to transfer DV to your hard disc. For that you need a computer with an OHCI-compliant 

interface and an IEEE 1394 port.    

A standard model will be required for newer Windows PCs  and  a newer-model for Macintosh 

computers. Instead of this you can opt for an appropriate DV capture card to provide the IEEE 1394 port. 

An accompanying OHCI-compliant driver and special Adobe Premiere Pro plug-in software may be 

required. Premiere comes with presets for a wide variety of DV capture cards.  You still  need to check 
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the instructions provided with the capture card you are using, to set up a special preset.   The capabilities 

of device control vary depending on the brand and model of playback device you are controlling.  

Premiere provides device control for an extensive range of DV devices. To specify the DV device in your 

computer, do the following:  

1. First attach and install an appropriate digital video device in your computer.  

2. Choose Edit > Preferences > Device Control. 

3. Click the Options button in the Preference window to see the DV Device Control Options dialog box.  

4. Now select your DV device and click OK. 

 

Fig10: DV Device Control Options Dialog Box1 

4.4  Capturing Clips with Device Control  

Device control refers to control of the video deck from within Premiere when capturing clips. Use it to 

capture video from analog or digital video decks or cameras. With device control you can do the 

following:  

• Control the tape deck and view its source video directly from Premiere instead of switching between 

Premiere and the tape deck controls.  

• Use the 'Capture‘ or 'Batch Capture' windows to create a list of In points (starting timecode) and Out 

points (ending timecode) for each clip, and then record all clips in the list automatically.  

• Capture the timecode on the tape so that Premiere uses it during editing.  

Use this checklist to prepare for capturing with device control:  

 

Make sure you have the following necessary equipments:  

 A frame-accurate tape deck that supports external device control.  

 A cable that connects the deck to your computer.  
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 A Premiere-compatible plug-in software module that allows you to control the tape deck directly 

from Premiere.  

 Source videotape recorded with timecode.  

 Set the device control options for capturing. 

 

Fig11: DV Device Control Options Dialog Box2 

 

Capturing Clips without Device Control 

You can capture video from analog or DV camcorders or decks by using the Capture window if you don't 

have a, controllable playback device. Manually operate the deck while watching the picture in the Capture 

window. Premiere controls and  records the frames you want. Use this method to capture video being 

played from an inexpensive consumer VCR or camcorder.  

4.5   Using Offline Files 
Adobe Premiere Pro automatically creates an offline file, or placeholder, for any source file used in the 

project that is not currently available on disc. You can also create an offline file at any time. For example, 

if you expect to use source video that has not yet been captured, you can create an offline file as a 

temporary substitute for the missing source video during editing. When the actual source video becomes 

available, you can quickly replace all instances of the offline file in a project with the actual source. 

Offline files remember information about the missing source files they represent. If an offline file appears 

in the timeline, a ―Media Offline" message appears in the program view and on the track. 

Use offline files in situations such as the following:  

 When clips are logged but not yet captured. When the offline files are captured or located, they 

replace the corresponding offline files.  
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 When you want to capture logged clips using device control or batch capture.  

 When you want to recapture clips used in the project. For that you must make the online clips offline 

by using the Project> Unlink Media command. 

 If a source file is unavailable when you open a project, so that Adobe Premiere Pro can not locate it 

automatically and you can not locate it manually. Adobe Premiere Pro provides Offline and Offline 

All buttons in this case.  

To Edit an Offline File:  

In the Project window, double-click the offline file, edit options as needed, and then click OK.  

To Replace an Offline File with a Source File that is Already Captured:  

1. In the Project Window, select one or more offline files.  

2. Choose Project>  Link Media.  

3. Do one of the following, and click OK:  

 Locate and select the actual source file.  

 Click Cancel if you can't locate the file that you wanted to  be linked  to.  

To Convert an Online File into an Offline File: 

1. In the Project  Window, select one or more online files.  

2. Choose Project> Unlink Media.  

3. Select one of the following options, and click OK:  

 Media Files Remain On Disc make the selected files offline in the project but don‘t  erase 

the source files from the disc.   

 Media Files Are Deleted make the selected files offline in the project and erases the 

source files from the disc.  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____________________________________________________________________________________ 

Unit Summary 
By the end of this unit, students will understand the difference between analog media and digital media, 

use of capture window, using markers, setting sync and track locks. We have also discussed how to create 

and work on offline files. Importantly, students will develop confidence and familiarity while working 

with Adobe Premiere Pro. 

____________________________________________________________________________________ 

Assignment 

Give a detailed explanation of - 

 What is the difference between analog and digital media? 

 Describe the different digital file formats with relevant examples. 

 How  will you capture clips with Device Control? 

__________________________________________________________________________________________ 

 

Terminology 

DECODE: To divide an encoded video signal into its separate components. 

 

DIGITIZE: To convert analog video or audio to digital form. 

 

DIGITAL VIDEO: Video that consists of a binary signal, encoded as a series of zeroes and ones. All 

data that a computer processes must be digital, so analog video must first be 

converted to digital video before it can be edited on a computer. 

 

DV: Generally refers to digital video, but also connotes the type of compression used 

by DV systems and formats. DV also describes the tape cartridge used in DV 

camcorders and tape decks. 

 

RAW FOOTAGE: Original, unedited film or video footage that has not been modified. 

 

FRAME RATE: The number of frames per second displayed during playback. 

 

IEEE 1394: The interface standard that enables direct transfer of DV between devices, such 

as a DV camcorder and a computer. IEEE 1394 also describes the cables and 

connectors using  this standard. Also called FireWire or i.LINK.  

 

DROP FRAME: Missing frames lost during the process of digitizing or capturing video. Dropped 

frames can be caused by a hard drive with a low data transfer rate. 
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Unit 5 
============================================================ 

Using the Tools 
 

 

 

 

 

 

 

Introduction 
In this unit, you will learn how to use the tool palette for editing clips in the Timeline window. Click on 

any of the buttons or use the keyboard shortcuts to select each tool. The default tool in Adobe Premiere 

Pro is the selection tool. When you select a tool the mouse pointer will usually change to a new icon to 

represent the tool when held over the Timeline panel. The tools are described in this unit with more 

description. 

Learning Objectives 

After completion of this unit you will be able to: 

 Learn about the different type of tools in video editing. 

 Work with different  clips. 

 Know various trimming modes in video editing. 

5.1  Working with Tools 
Adobe Premiere Pro  gives a number of tools that help you to work faster and with more precision. You 

can carry out all the essential editing to your video project. This palette is open by default.  

 

Fig12: Tools Palette 

Watch this video on using different tools during video 

editing at goo.gl/tRi6B1 

 

 

 

https://goo.gl/tRi6B1
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Selection Tool  

Selection tool is useful in selecting and moving the clips, transitions as well as markers. The symbol of 

this tool changes to a stretch pointer, when it is positioned at the edge of the clip. This stretch pointer is 

useful changing the duration of the clip as it shortens or enlarges it while dragging. 

 

To Select a Clip in the Timeline Window:  

1. Choose the selection tool from the tool palette.   

2. Click on the clip you want to select. The selected clip will get highlighted.   
 

To Select or Deselect  Multiple Clips in the Timeline Window:  

1. Choose the selection tool from the tool palette.   

2. Hold Shift key and click on each clip you want to select. The selected clips will get highlighted.   
3. Hold Shift key again and click on each clip you want to deselect.  

 

To Select a  Range of  Clips in the Timeline Window: 

1. Choose the selection tool from the  tool palette. 

2. Click on an empty area in the Timeline window and drag a rectangle (marquee selection) over the 

clips  you want to select.  

 

To  Add or Subtract a Range of Clips, in the Current Selection in the Timeline Window: 

1. Choose the selection tool from the tool palette.   
2. Hold  shift key and drag a marquee to add clips (if they were unselected) or subtract clips (if they 

were  selected) in the current selection.   

To  Select a Clip,  Independent of its Linked  Video or Audio in the Timeline Window:  

1. Choose the selection tool from the tool palette.   

2. Hold Alt key and click on either video or audio of a linked clip to select it.   

Track Selection Tool 

Below the selection tool is the track selection tool. This tool is useful in selecting all the clips of the 

tracks. 

To Select all Clips that Exist  On, and After a Certain Time on One Track in the Timeline Window:  

1. Choose the Track Selection tool from the tool palette.   

2. Click the clip at the start of the time span you want to select.  

 

To Select all Clips that Exist On, and After a Certain Time on all Tracks in the Timeline Window:  

1. Choose the Track Selection tool from the tool palette.   

2. Hold shift key and select clips in all the tracks you want to select.   
 

To  Select Clips in a Track, Independent of its Linked  Video or Audio, in the Timeline  Window:  

1. Choose the Track Selection tool from the tool palette.   

2. Hold Alt key and click on either video or audio of a linked clip to select it.   

Ripple Edit Tool 

A ripple edit tool adjusts a clip's in or out point, making the clip longer or shorter, without leaving a gap 

in the timeline.  A ripple edit maintains the durations of all other clips by changing the program duration. 

When you drag the edit line, the overall program duration is lengthened or shortened. The program 

duration changes by the number of frames added or subtracted from the clip on the edit line. An empty 

space on one side of the edit point is treated as a clip and is adjusted by the ripple edit tool just as a clip 

would be.  
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Rolling Edit Tool 

The rolling edit tool allows you to change an edit point (in and  out point) without affecting the rest of the 

timeline.  A rolling edit keeps the program duration constant. It also maintains the combined duration of 

the two clips that you are editing. When you adjust the edit line, the frames added or subtracted from one 

clip are subtracted or added from the clip on the other side of the edit line. To make a L-cut, turn off 

Synch mode before performing a rolling edit.  

 

Rate Stretch Tool 

Rate Stretch tool allows you to change the clip‘s speed/duration without affecting the other clip. 

 

Razor Tool 

Razor tool allows you to split a single clip or linked clip.  When a clip is split, a new and separate instance 

of the original clip is created. It is quite useful when different effects have to be used, but those which 

cannot be both applied to a single clip. When a clip is split, a new instance of the clip and any clips to 

which it is linked is created.  

 

To Split a Single Clip or Multiple Movie Clips Using the Razor Tool, do the Following:  

1. Select the Razor tool from the tool palette.   

2. Click at the location in the sequence where you want to split the clip or clips.   
 

Slip Tool 

A Slip tool is useful in moving the starting and ending frames of a clip forward or backward. It does this, 

without affecting anything else in the Timeline window. When you drag a clip to the left or right, its 

source In and Out points shift accordingly. The program duration and the source and program In and 

Out points of all other clips remain unchanged.  

 

Slide Tool 

Slide tool allows you to click/drag on the clip in the sequence.  A Slide edit preserves the duration of a 

clip and the program by changing the In and Out points of the preceding and following clips. When you 

drag a clip to the left or right, the Out point of the preceding clip, the In point of the following clip, and 

the clip's program In and Out points are moved by the number of frames you move the clip. The In and 

Out points of the clip's source and the program duration do not get changed. The slide tool does not 

require there to be a clip on either side of the clip you are adjusting.  

 

Pen Tool 

Pen tool allows you to create control (anchor) points in the timeline window. 

 

Hand Tool  

Hand tool is useful for displaying parts of clips that are not visible. Instead of using the scroll pane to pan 

an area you can use the Hand tool. Select the Hand tool, and drag over the clips in the Timeline window, 

to pan areas that are not visible.  

 

Zoom Tool  

In the timeline window the zoom tool allows you to magnify the view, or drag and select a rectangular 

area to zoom.  The zoom tool is useful for magnifying the clips in the timeline window.  
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To Zoom in on the Clips in the Timeline Window:  

1. Choose the zoom tool from the tool palette.   

2. Click on the area, or drag the zoom tool over an area to magnify it.   
 

To Zoom In and Out the Clips in the Timeline Window:  

1. Choose the Zoom tool from the tool palette.   

2. Hold Alt key and click on the area to zoom out.   

 

5.2   Working with Clips 
One of the good things about Adobe Premiere Pro is that you can easily add clips anywhere in a sequence, 

move them around in a sequence, or remove them altogether. In this guide tour you will add a few clips to 

a sequence, place other clips within that collection of clips, remove the clips, and rearrange clips within a 

sequence. Any clip that you import is a source clip. It is a reference of the clips that is stored on the hard 

disc. Clips that you import can be used as source clips, clip instances, or duplicate clips. Any types of 

clips can be edited in sequences in the same way. The differences between clip types are as follows:  

 

Source Clip 
Source slip is a clip that you import in the Project window. The clip can be of any type. It is listed in the 

Project window only once by default. If you delete a source clip from the Project window, all  its 

instances are also deleted.  

 

Clip Instance 

Clip instance is a dependent reference to a source clip that is used in a sequence. Another instance of the 

clip is created every time you add a clip to a sequence. A clip instance, uses the name and source file 

reference used by its source clip, but  the name of a clip instance is not updated if the name of its source 

clip is changed. Clip instances are not listed in the Project window. They are differentiated in the Source 

view menu if you open instances there. The Source view menu lists instances by name, sequence name, 

and in-point.  

 

Duplicate Clip 

Duplicate clip is an independent copy of a source clip. A duplicate clip maintains its own reference to the 

original clip's source media file on disc unlike a clip instance. It exists as an additional clip in the Project 

window. Even if you delete a duplicate clip, its original clip is not deleted. You can rename master and 

duplicate clips independently. 

5.3   The Trimming Modes 

There are five trim modes in Premiere Pro. Those five modes are regular, ripple, rolling, slip, and 

slide.  

Let us  learn how to use each one. 

Regular Trims 

You do not have to click any buttons in the Tools panel or the Timeline to access the regular trim tool.  If 

you hover your mouse pointer over the edge of a clip, you will see it turn into the regular trim tool.  

It looks like this: 

 
Fig13: Most basic look of the trimming tools 
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NOTE:  Remember that if your audio and video files are linked, you will trim both of them when you 

trim one.   For that reason, before you start to trim, you should unlink the tracks if you do not want that to 

happen. 

The regular trim tool is a red arrow, as  shown above.   However, where it appears will let you know what 

you can do with it. 

Here is what we mean. In the snapshot above, you can drag inward or outward using the tool.   If the tool 

had down up on the clip, instead of on the outside of the clip, it would mean that you could only drag 

inward. When you reach the beginning or end of a clip, you will not be able to drag any further when 

dragging outward. In order to extend the length of the clip, you will have to slow the playback speed.  

 When dragging outward: 

 You cannot use the regular trim tool when the clip shares a border with another clip or the start of a 

sequence. 

 You cannot use the regular trim tool when dragging outward will move other clips.  

This is how to use the regular trim tool to trim a clip on the Timeline. 

Hover your mouse over the edge of a clip. You can trim inward or outward. The choice is yours. 

Drag the edge of the clip in the direction you want to go. There will be a yellow box next to the pointer 

that shows you the length of the trim. It will be a positive number if you drag to the right. It will also 

show the duration of the clip.  

 

Fig14: Trimmed clip duration 

If you look at the Program Monitor, you will see it shows the length of the trim and clip duration. It also 

shows the original timecode of the frame being displayed. This makes it easy to trim to a known frame in 

the source clip. 

Ripple Trims 

The ripple trim is like an insert edit if you lengthen a clip. It is like an extract edit if you shorten a 

clip. This type of trim affects all synced tracks unless you disable Sync Lock.  

The ripple trim tool looks just like the regular trim tool except that it is yellow instead of red.  

To use the ripple trim tool, go to the Tools panel and click the Ripple Edit tool. It looks like 

this:   You can also press B. 
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Next, hover your mouse pointer over the edge of the clip you want to trim. You will see the pointer 

change to the ripple tool.   Drag in the direction you want to go.  

As with the regular trim tool, you will see a yellow box that shows the length of the trim and the clip's 

duration.  

In the Program Monitor, you will see the length of the trim and the clip's duration.   You will also see two 

frames displayed. One shows the new trim point. The other shows the adjacent clip.   

 

Fig15: Trimming point and adjacent clip 

Rolling Trims 

A rolling trim's purpose is to adjust the meeting point of two neighbouring clips, but keeping the In point 

of the first clip or the Out point of the second clip fixed.   

In a rolling trim, one clip is shortened, but the other clip is lengthened by the same amount that the first 

one is shortened.  It is taken from one (in terms of length) and given to the other. 

This edit should be used to change how one clip flows into another. 

To make a rolling trim, click on the Rolling Edit tool in the Tools panel. It looks like this:  

Hover your mouse over the point where the two clips meet. You will see the pointer change to the rolling 

edit pointer. 

Now, drag the edge in the direction you want to go. 

In the screenshot below, we are dragging inward. We added the arrows to the screenshot to show the 

direction of the drag. 

 

Fig16: Rolling Trims 

As you can see above, the yellow box appears as it did with other trims. 

In the Program Monitor, you can see the trim's duration, as well as the second clip's duration. You will 

also see two frames; the last frame from the first clip on the left, and the first frame of the second clip on 

the right. 
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Slip Edits 

Slip edits are one of the neatest ones that Premiere Pro offers. Let us  say that you set In and Out points in 

a source clip in the Program Monitor. You move it to the Timeline and realize that you need a few more 

seconds of the source footage than you originally thought.   

This could be a real problem without the slip edit. You would have to remove the clip from the Timeline, 

go back to the Program Monitor, then adjust your In and Out points, etc.     

However, by using a slip edit, you can make the adjustments right in the Timeline. You can just drag the 

content in that clip forward by the number of seconds you need. 

To make a slip edit, click the Slip tool in the Tools panel. It looks like this:  

Your mouse pointer then turns to the slip pointer. 

Next, click the clip you want to trim. Drag it to the right to extend the seconds. Drag it to the left to 

decrease the seconds. 

In the Program Monitor, the two large frames show you the In and Out points of the clip. The source 

timecode is shown as well. The smaller frames show the adjacent clips. These will not change. 

 
 

Fig17: Time code of the clip 

Slide Edits 

A slide edit is by far the most difficult of the edits to get used to. Part of the reason is because the slide 

edit involves three clips instead of just one or two.  

In a slide edit, the In point for the first clip, as well as the Out point for the third clip do not change.  The 

middle clip does not change at all.  Instead, you will either shorten or lengthen the first clip with the 

reverse happening to the third.  If you shorten the first clip, you lengthen the third and vice versa. 

You will use the middle clip to shorten or lengthen the first and third clips. 

To make a slide edit, click the Slide tool in the Tools panel. It looks like this:  

Next, click the middle clip of the three you want to edit, then drag in the direction you 

want to go. 

Release the mouse when you are finished. 

Trimming in the Program Monitor 

The Program Monitor can be a better place to trim your clips if you are working in audio, because you 

will be able to hear the audio while you trim.   However, only three trims are available in the Program 

Monitor. These trims are the regular, ripple, and rolling.   

To get to the trim mode in the Program Monitor, you can press the T key or double click on any edit point 

with either the regular, ripple, or rolling tool. You can also drag a marquee around an edit point using the 

ripple or rolling edit pointer, as shown below. 
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Fig18: Trimming on the monitor 

Here is how the controls work: 

 Trim Backward Many trims backward by the number of frames that you have specified in the Trim 

Preferences Dialogue box (Edit>Preferences>Trim) 

 Trim Forward Many is the same as Trim Backward Many except that it trims forward. 

 In Shift Counter is how many frames the In point of the second clip has been changed. 

 Trim Forward trims forward one clip. 

 Trim Backward trims backward one clip. 

 Out Shift Counter shows how many frames the Out point in the first clip has been changed. 

 Trim Mode Indicator shows the type of edit. A blue line under both windows is a rolling edit. If it is 

just under one window it is a regular or ripple edit. 

To choose an editing mode, right click on the intersection between the two clips in the Timeline: 

 

Fig19: Split Edit 
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The best way to learn the different trimming techniques both in the Timeline and the Program Monitor is 

to take time to practise them.  You will get a better feel for how each works, and you will learn which one 

to use when you need to trim clips in your projects. 

About Split Edits 

Split Edits are also known as L-cuts and J-cuts.   These are edits where audio can be heard before the 

video is seen (J-cut) or audio still plays after the video goes to the next clip or scene (L-cut). You use the 

Rolling Edit too to perform split edits. 

To create a rolling edit, go to the Tools panel and click the Rolling Edit tool. You can also press N. 

We are going to use two audio tracks as an example. 

Now, hover your mouse between the audio clips you want to trim. You will then see the rolling edit 

pointer. 

Next, Alt+click where these two files intersect. The edit will be applied to the selected video track. 

Drag the edge in the direction you want to go. If you go to the right, it produces a J-cut. If you go to the 

left, it produces an L-cut. 

Change the Clip Speed 

Click the clip for which you want to change the speed.  We are going to speed up the click we have 

selected below. 

 

Fig20: Clips dialog box during trimming 

Next, right click on that clip and choose Speed/Duration from the menu. 

You will then see the Clip Speed/Duration dialogue box. 

 

Fig21: Clip speed dialog box 

Enter the desired speed or duration.  

You can select Reverse Speed if you want the clip to run in reverse. 

If the clip has audio you want to use, check Maintain Auto Pitch. 

Check the Ripple Edit, Shifting Trail Clips if you want to ripple the edit through the other clips on the 

track, as well as synced tracks.  Not checking this box will leave a gap if you make the clip faster. If you 

slow the clip down, it will not extend beyond the original Out point. 



 Page 49 
 

 

___________________________________________________________________________________________ 

Unit Summary 

In this unit you have learnt about the various tools and their working on Adobe Premiere Pro and also 

working with different clips. 

We have also learnt working with clips and different clips like source clip, clip instance and duplicate 

clips. The different trimming modes like regular, ripple, rolling, slip and slide edits were also discussed. 

After completion of this unit you will be able to know how Adobe Premiere Pro tool is designed for your 

editing. 

___________________________________________________________________________________________ 

Assignment 
Give a detailed explanation of - 

 What are the different types of tools in the Adobe Premiere Pro editing software and how are these 

tools used? 

 What are the different type of clips and how are they different from each other? Explain. 

 What are the different trim modes used in Adobe Premiere Pro? 

___________________________________________________________ 

Terminology 

RASTER: A grid of pixels forming the image on a TV or computer screen. 

 

PROJECT PRESET: A predefined set of values that can be used for project settings. 
 

KEY FRAMES: Start and end point for animated effects. Adobe Premiere Elements automatically 

generate the frames between key frames to create smooth movement. 
 

FRAME: A single still image in a sequence of images that when displayed in rapid 

succession, creates the illusion of motion. The more frames per second (fps), the 

smoother the motion appears. 

 

FIELDS: The set of alternating horizontal lines that create an interlaced image on a TV 

screen. A complete TV frame consists of two fields: The odd-numbered lines of 

field one are interlaced with the even-numbered lines of field two.  

 

16:9: The aspect ratio of widescreen TV. 

 

MPEG: Motion Pictures Expert Group. Also, a type of compression and a video format. 

MPEG compression calculates and encodes only the differences between one 

frame and its preceding frame 
 

JPEG: Joint Photographic Experts Group. Also, a file format defined by the  group for 

compressing still images.  since  video is a sequence of still images, JPEG 

compression can be used to compress video. 
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Unit 6 
============================================================ 

Start the Magic (Editing) 
 

Introduction 

Before you start  with hardcore editing in Adobe Adobe Premiere Pro, there are two very important things 

you should know about- 

(i) Organizing your content, and  

(ii) Creating sequences  

Both of these will be critical to you as you work on creating your video in Adobe Premiere Pro. 

Learning Objectives 

After completion of this unit you will be able to: 

 Learn about Timeline window and its different settings. 

 Use the Metadata Panel. 

 Create the sequences matching the specific formats. 

 Handle the timeline confidently. 

6.1  What is the Timeline? 
Timeline is a time-based representation of your program. You assemble and edit your video in the 

timeline window. When you start a new project, the timeline is empty. You can create and nest multiple 

timelines in a single project. This feature allows you to assemble scenes on different timelines and then 

nest them on the master timelines. The timeline window displays time horizontally. Clips earlier in time 

appear to the left and clips later in time appear to the right. Time is indicated by the time ruler near the top 

of the timeline window. The time zoom controls at the lower left of the timeline allows you to zoom in or 

out of the time scale. 

 

The Timeline Controls 

A snapshot of the Timeline is shown below.   We have labelled the different buttons and controls for 

you.  You can reference this as we work with the Timeline.  

 

 
Fig22: Timeline 
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Time Ruler displays time within the Timeline. It goes from left to right. 

 

Timeline Panel Menu offers configuration options for the Timeline. 

 

Toggle Track turns a track on and off. If you turn it off, you will not see the content in the Program 

Monitor. 

 

Solo Track plays the audio for that track only during playback. 

 

Mute Track mutes that track during playback. 

 

Toggle Sync Lock toggles sync lock on and off. Sync Lock keeps tracks in sync during edits. 

 

Toggle Track Lock toggles locking on and off. When you lock a track, you cannot edit the content. 

 

Track Header is the area to the left of the Timeline track. 

 

Time Code shows you where the playhead is at in your project. 

 

Snap(S) controls if items are snapped to each other when moved. 

 

Add Marker(M) adds a marker to the Timeline. 

 

Customizing the Timeline  

Having the right tools and features to work on your project is important. However, it is also important to 

be able to customize the different panels to make editing easier. Now we are going to learn how to 

customize the Timeline. 

We are going to learn how to: 

1. Customize the track height 

2. Increase the height of audio or video tracks 

3. Increase or decrease the height of a single track 

4. Turn track thumbnails on or off 

5. Changing the appearance of thumbnails 

6. Customize audio tracks 

 

Customizing the Track Height 
As you can see in the snapshot below, the track height is small by default. You cannot see any of the 

content because they are so minute. 
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Fig23: Track height customization of  Timeline 

As you can see in the snapshot above, the height of each track is expanded. We can now see some 

content. We have one video track, then an audio track that shows the left (L) and right (R) speakers. 

If you want to minimize the tracks, go back to the Timeline Display Settings menu, then select Minimize 

All Tracks. 

 

Expanding Video or Audio Tracks 

To expand either video or audio tracks, grab one of the edges of the vertical zoom bar for either the audio 

or video track. Drag inward if you want to increase the size. Drag outward if you want to decrease the 

size. 

 

Expanding the Height of a Single Track 

Sometimes you may only want to expand the height of one track. Perhaps it is the one you are working 

on. To do this, go to the track header area. 

Put the mouse pointer at the top of the track you want to expand. You will then see the height adjustment 

pointer. You will see a light grey line at the top of the track, as shown below. 

 

 
Fig24: Single track height customization  

Now you can drag upward to expand the track.   Drag downward to decrease the size of the track. 
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Turn Track Thumbnails On or Off 

By default, whenever a video track is showing in the Timeline, you can see thumbnails that are visible 

when you expand the track. You can see the thumbnail of the video below. 

 

 
Fig25: Turn Track Thumbnails On or Off 

 

These video thumbnails are enabled by default. However, you can disable them – and re-enable them – 

whenever you want. To disable thumbnails, click the Timeline Display Settings button, then select Show 

Video Thumbnails. If there is a checkmark beside it before you select it, then selecting it will disable the 

feature. Click to put a checkmark beside it to enable the feature. 

Customizing Thumbnail Appearance 

You can also customize the way thumbnails appear in the timeline. To do this, go to the panel menu.  

Choose one of the three options listed below: 

 

Video Head and Tail Thumbnails shows a thumbnail of the first and last frame. There is blank space in 

between. In the snapshot below, we scrolled across to the last frame. You can see the thumbnail. 

 

 
 

Video Head Thumbnails shows the first frame, then blank space. 

 

 
 

Continuous Video Thumbnails shows all thumbnails in the clip. 
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Working with Audio Tracks 

You can also customize the appearance of your audio tracks in Adobe Premiere Pro. 

In the snapshot below, we see the wave form of the audio track.  

 

 
 

The waveform you see in the snapshot above is called a Rectified Audio Waveform. The positive and 

negative values of the waveform are combined so you only see a single positive value from the bottom of 

the track. However, you can also view the traditional waveform if you wish. 

 

The rectified waveform is the one shown by default. To see the traditional waveform, go to the panel 

menu and select Rectified Audio Waveforms. 

 

 
Fig26: Panel Menu 
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If you want to switch back to Rectified Audio Waveforms, simply go to the panel menu again.  

Place a checkmark beside Rectified Audio Waveforms. 

 

Adding a Single Audio or Video Track 

The number of video and audio tracks displayed on the timeline can be controlled by creating a  

reset. Tracks can always be added or deleted while you are working in Premiere Pro. 

 

To add a single track, right click in the video track header area to add a video track. Select Add Track 

from the menu. 

 

 
Fig27: Single Track Addition 

 

To add a single video track, right click in the audio track header area and select Add Track. 

If you want to delete a track, right click in the header area, then select Delete Tracks. 

If you want to add multiple tracks, right click in the header area. Select Add Tracks.  

You will then see the Add Tracks dialogue box. 

 
Fig28: Single Track Addition Dialog box 

 

In the Add field, enter the number of tracks you wish to add. 

Select the placement of these tracks in the Placement field. 

Do the same thing for audio tracks in the Audio Tracks section (picture above). 

For audio tracks, select a track type. Premiere Pro has six different audio tracks: 

 

 Standard can have both stereo and mono audio tracks. It is the default setting. 

 Mono has one audio channel.   A stereo file is converted to mono in Premiere Pro. 
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 5.1 is surround sound tracks. This includes three front audio channels. These are left,  centre  and 

right. It also includes two rear channels, left and right plus a low-frequency subwoofer channel. 

 Adaptive can have mono or stereo tracks. 

 Audio submix track is a synthetic track that does not have any audio that is sent to it from other 

audio tracks. 

 Master audio track controls the output of all tracks in the sequence. It allows you to adjust the 

volume for tracks using a single slider in the Audio Mixer. 

If you want to delete multiple tracks, click in the header area, then select Delete Tracks. 

You will then see the Delete Tracks dialogue box. 

 

 
Fig29: Delete tracks Dialogue box 

 

Identify the tracks that you want to delete. 

Click OK when you are finished. 

 

Changing the Time Code Display Format 

In Premiere Pro, you can choose from two different Time Code display formats.   These are Drop-Frame 

Time code and Non Drop-Frame Time Code. 

Let us look at the difference between the two in order to help you decide which you should use. 

Drop-Frame time code should be used if you are creating a video that has a certain time length, such as 

ninety minutes. Time code really has little to do with the actual time. Instead, they mark specific frames 

in the video which occur at 29.97 fps (frames per second). That means 30 frames of a 29.97 video take 

almost a second, but not a complete second. A one hour video actually has the time of 60 minutes and 3.6 

seconds. If your video has to  be broadcast, and you only have an hour, this could be a problem. Well, 

Drop-code time code skips ahead two frames every minute – except for the tenth minute. Frames are not 

dropped. Do not worry. The timecode jumps.  

Drop-frame time code is displayed with semicolons. Non drop-frame time code uses colons.  

To choose a time code display format, go to the time code in the Timeline. You will see your mouse 

pointer change to a hand with two arrows. Do not click your mouse.  Instead, right click.  

When we talk about the timeline panel, however, metadata can be so important to your project that we 

will spend some time talking about it more in depth.  
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6.2 The Metadata Panel 

 

 

 

 

 

 

 

By definition, metadata is data that gives information about other data. If you have a JPEG image, for 

example, the metadata would provide information about that image. This information may include the 

type of camera, the size, etc. 

 

The metadata panel in Adobe Premiere Pro is located with the source monitor. Click on the Metadata tab 

to the right of the source monitor tab to view it. 

 

Whether or not you ever use the metadata panel will depend on the type of projects you have. The 

Metadata panel is used mostly for movies or projects where many clips are used.  

The Metadata panel is shown below. 

 

Fig30: Meta Data Panel 

There are two types of metadata that are  managed by the Metadata panel. These two types are file-based 

and clip-based. File-based metadata is stored in the file itself.   Any metadata that is in the fields shown in 

the snapshot above can also be viewed by other programs when the file is opened in those programs. Clip-

based metadata is only stored in Premiere Pro. It cannot be seen in other programs. To enter metadata into 

Premiere Pro, first select a clip or image in the Project panel, as we have done below. 

Watch this video on using different tools during video 

editing at goo.gl/chsgqB  

 

https://goo.gl/chsgqB
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You see that the Metadata panel has three sections: Clip, File, and Speech Analysis. Click the triangle that 

is next to each section name to see other metadata fields available. 

We clicked on File Properties in the snapshot below. This gives  us information about the file. Remember, 

this is file-based metadata, so it is metadata that will also be available in other programs. 

 

To enter metadata, use the back and forward arrows at the top left of the Metadata panel to scroll through 

fields. You can see a grey text field where you can enter information, as shown below. 
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Click Enter after you have entered the data. 

 

6.3  Analysing Content 
In addition to the type of metadata that you enter into the Metadata panel, there is also metadata that 

Premiere Pro can find by analysing source clips. Premiere Pro has the ability to find faces in your clips, as 

well as convert audible speech to text.   

To show you what we mean, let us learn to find faces in source clips. To do this, go to the Project panel, 

and select a clip to analyse by clicking on it. 

Next, go to Clips>Analyse Content. You will then see the Analyse Content dialogue box. 

 

Fig31: Analyse Content dialogue box 

Make sure Face Detection is checked. Click OK.  When you click OK, the Adobe Media  

Encoder starts to work in the background. You will not notice anything at all. In fact, you may think it 

didn't work because nothing happens right away. However, you can do some other editing while you 

wait. When Media Encoder is finished, it will play a sound to let you know. Click the magnifying glass in 

the Find box, and then choose Find Faces from the menu. You are seeing all clips with faces displayed. 

Click Close to restore your clip. 



 Page 60 
 

To use speech analysis, ensure the speech box is checked. The text will appear in the Metadata panel 

under the Speech Analysis section. 

6.4  Working with Sequence 

 

A sequence is a series of shots that should get an object or a person from point A to point B. All shots in 

the sequence should have a commonality to them either by time, location, or elements in the shot.  

Creating Sequences 

The world revolves around sequences. In Adobe Premiere Pro, you can create many sequences.  Here are  

a few facts you need to know about sequences: 

 You can have several sequences in a project. 

 You can insert a sequence into a sequence. This is called a nested sequence. 

 You can copy and paste a sequence. 

 You can delete, rename, and search for a sequence. 

What you cannot do is change a sequence's preset once it is created. For that reason, you have to set it up 

right the first time. Otherwise, you have to copy and paste edited clips into a correct sequence. Although 

it is not hard to do, it takes up time that you could spend doing other editing tasks. 

You should  remember the three "rules" when you apply a preset to your sequence. Generally, in order to 

get things "just right," you should choose one of these rules to follow when choosing a preset. 

1. The sequence preset should match the bulk of your source footage. This is the most commonly 

followed rule. 

 

2. Your preset should match your target output.  

3. Your sequence should match your project size. For example, for 640x360 videos, create a 640x360 

preset. 

Now that we have covered the three rules,  let us  learn how to create the presets for those rules. 

Matching Source Footage 

To create a preset that matches your source footage, drag the footage to the New Item button.  

Watch this video on using different tools during 

video editing at goo.gl/61Fzjk 

 

https://goo.gl/61Fzjk
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Fig32: Matching Source Footage 

Premiere Pro will create a sequence in the Timeline that has the same name as the footage. 

 

Click OK. 

Matching a Specific Format 

If you want to create a sequence that matches a specific format, you will  need the following information 

to do so: 

 Resolution 

 Format type 

 Frame rate 

 Aspect ratio 

 Broadcast standard, 

 Progressive or interlaced format 

 

You can check the settings on your camera for some of the information. You can also go to the Project 

panel and open the Preview Area for the clip. 

Selecting a Sequence Preset 

To select a sequence preset, start out by creating the sequence.  

To do this, click the New Item button in the Project panel and select Sequence.  

You can also go to File>New>Sequence. You will then see the New Sequence dialogue box. 
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Fig33: Selecting a Sequence Preset 

 

Click the triangle next to the different preset categories in the Available Presets section. You can click on 

any preset and see the details displayed in the Preset Description field. Once you have chosen the preset, 

enter a name for the sequence in the Sequence Name field. Click OK. 

If the clip does not match the sequence's settings, you can see a warning box appear. You can either 

change the sequence settings or you can keep them if the discrepancies between the clip and the sequence 

are  intentional. 

Creating a Custom Preset 

To create a custom preset for a sequence, create a new sequence as we did in the sequence preset. When 

you see the New Sequence dialogue box, click the settings tab in the dialogue box. 

 

Fig34: Sequence dialog box 
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Go to Editing Mode and select Custom, as circled below. 

 

Next, go to the Time base dropdown menu to select the Frame Rate. 

 

In the Frame Size fields, enter the horizontal and vertical values. 

 

The Pixel Aspect Ratio should be square for non-broadcast projects.  
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Choose the Pixel Aspect Ratio from the dropdown menu. 

 

Choose your preferred settings from the Fields dropdown menu. 

In the Display Format section, choose the desired format from the dropdown menu. 25/30 fps Time code 

is the recommended default format for PAL/NTSC. 

Next, select your desired sample rate from the Audio Sample Rate dropdown. 

 

You can leave all the other settings alone and click the Tracks tab at the top of the dialogue box. 

This tab will show you audio settings.  

Select the number of video tracks that you want to insert in the new sequence, and then go to the Master 

and Track Type dropdown menu to see the settings available. 
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Click the Save Preset button when you are finished. You will then see the Save Settings dialogue box. 

 

Fig35: Save Setting dialog box 

Enter a name and description for the preset, and then click OK. 

Enter a name for the sequence at the bottom of the New Sequence dialogue box, then click OK again. 

About Sequence Settings 

To check the settings for your sequence, right click on the sequence in the Project panel. Select Sequence 

Settings. 

You will then see the Sequence Settings dialogue box. 

 

Some of the fields in the Audio and Video sections will not be active for you, so you cannot change 

them. However, you can change how the format is displayed in the sequence. 
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______________________________________________________________ 

Unit Summary 
In this unit you have learnt about the timeline window to make your storyboard alive and also different 

settings of the timeline window and  use of metadata in sequence to get your best result. 

You have been told  about creating the sequences, matching source footage, matching  specific formats, 

selecting a sequence preset, creating a custom preset and about sequence settings. 

______________________________________________________________ 

Assignment 

 Define the timeline window.  

 How do you create a sequence? 

 What do you understand by metadata?   

__________________________________________________________________________________________ 

Terminology 

Time Ruler :  Displays time within the timeline. It goes from left to right. 

 

Solo Track :  Plays the audio for that track only during playback. 

 

Time Code :  Shows you where the play head is in your project. 

 

Snap:   Controls if items are snapped to each other when moved. 

 

Track Header : Track Header is the area to the left of the timeline track. 

 

Nested Sequences: A nested sequence is when you insert a sequence into another sequence. 

 

Rough Cut: A preliminary version of a video production, often assembled from lower quality 

clips than those used. 

 

Final Cut: The final video production, assembled from high quality clips, and ready for 

export to the selected delivery media. 
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Unit 7 
============================================================ 

Effects and Integration 

Introduction 
You have learnt how to edit the clips in the Timeline and Monitor Windows in the previous units. You 

also learnt about sequences and markers. 

In this unit, you will learn to create a storyboard in the timeline and apply effects. You will also learn how 

to apply transitions and integrate other Adobe products with Adobe Premiere Pro. 

After completion of this unit you will be able to: 

Learning Objectives 
 Work with different transitions used in editing. 

 Use different video effects. 

 Learn about different softwares integrated while editing on APP. 

 

7.1  Creating a Storyboard 
A storyboard is a series of illustrations that represent a process. To specify and organize the individual 

shots for a film or video, producers create a storyboard, which is a collection of sketches, descriptions, or 

both, laid out in order. Storyboard is useful for visualizing and planning your project. It is helpful in 

preserving your sense of continuity during production when you are  acquiring shots out of sequence. So 

once the shots are complete, it only seems natural to arrange them into storyboard form before 

committing them to a rough cut.  

 

With Premiere, you can organize clips in the Project window in storyboard fashion, and then generate a 

sequence automatically with video and audio transitions. In Premiere, you can easily and quickly organize 

a set of clips into a sequence, which is similar to using a storyboard. When you are satisfied with a 

sequence, you can move the entire sequence into a Timeline window, using the Automate to Sequence 

command to create a rough cut video.  

7.2  Working with Transitions  
Transition is a change in video from one clip to another. Often these visual changes involve effects in 

which elements of one clip are blended with another. 

 

Transitions are mainly placed at the end of one clip and the start of another clip. The simplest type of 

transition is the cut, in which the last frame of one clip is simply followed by the first frame of the next. 

Normally this term is used for film editing, where a cut means splicing two shots together. A cut is the 

Watch this video on using different tools during 

video editing at goo.gl/rQ6Xum 

 

 

https://goo.gl/rQ6Xum
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frequent and the most effective way to move from one scene to the next. There are many other transitions, 

which are useful in setting a mood or adding a creative element to your project.  

 

You will find transitions in the Effects panel. There are transitions for both audio and video. 

 

Fig36: Transition Effect Panel 

You can click on the triangle to the left of Video or Audio transitions to see the available transitions. We 

have clicked in the Video transitions. 

 

Fig37: Video Transitions 

Things to Know about Transitions 

1. Before we work more with transitions, there are a few facts  you need to know. 

a. Whenever you apply a transition effect, Premiere Pro uses frames from the two clips to create it. 

b. Transitions should be used for major scene changes. Do not overuse them. 

c. The mood of the project should be taken into account when adding a transition. Use a transition that 

matches the mood. 

Setting a Default Video or Audio Transition 

To set the default audio or video transition, go to the Effects panel. 

Click on the transition that you want to make the default transition. Choose a video transition for video 

and an audio transition for audio. 
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Right click on the transition and select Set Selected as Default Transition. 

 

Fig38: Default Transition 

Adding a Video Transition: To add a transition, drag a transition from the Effects panel and drop it at 

the intersection between two clips. 

 

Fig39: Adding a Video Transition 

You can see the transition between the two clips in the snapshot above. If alignment positions are 

available, choose the one you want.  

NOTE: You can view alignment positions by selecting the transition, then going to the Effect Controls 

panel. 

 

The default duration for a transition is one second. If you need to change this, go to 

Edit>Preferences>General. 
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Deleting a Transition 

To delete a transition, click on the transition and either press Backspace or right click, then choose Clear. 

Replacing a Transition 

To replace one transition with another, drag a transition from the Effects panel and place it on the 

transition you want to replace.   Premiere Pro replaces it for you. 

Changing the Duration of a Transition 

To change how long a clip lasts between two clips, right click on the transition in the Timeline. 

Choose Set Transition Duration. 

You will then see the Set Transition Duration dialogue box. 

 

Fig40: Changing Duration of a Transition 

Enter the duration you want, then click OK. 

Customizing Transitions 

Transitions can be customized in much the same way as we customized effects. 

To customize a transition, select it in the Timeline.  

Next, go to the Effect Controls panel. Make sure you can see the Timeline in the Effect Controls panel. 

 

Fig41: Customizing Transition 

Click the Play button in the Effect Controls panel to see a preview of your transition. 
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If you want to see your content instead of A/B slates, click Show Actual Sources. 

 

You can also click the Duration field to change the transition duration. 

 

Click the Alignment field to change the alignment. 
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Click Reverse to reverse the transition. 

 

For some transitions, you can also add a border by hovering our mouse over the values, then dragging to 

the desired values. You can also change the colour for the border by clicking the colour chip, then 

selecting  a colour from the Colour Picker dialogue box.  

When you click OK to close out the Colour Picker dialogue box, you can then preview the border in the 

Program Monitor. 

 

Adding the Default Transition to Multiple Clips 

To add the default transition to multiple clips, first select the clips in the Timeline. 

We are going to draw a marquee around the clips we want to select, as pictured below. 

 
Fig42: Adding the Default Transition to Multiple Clips 
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To drag a marquee, click in a blank area of the video area in the Timeline (if you are selecting video 

clips), press down the left mouse button and drag. 

Next, go to Sequence>Apply Default Transitions to Selection. 

When you do this, Premiere Pro inserts the default transitions. This includes fade-ins and fade-outs. 

Creating a Fade-In 

To create a fade-in so  that your clip fades in from black, go to the Effects panel. 

Drag the Cross Dissolve transition to the start of the video (in the Timeline). 

 

Creating a Fade-Out 

To create a fade-out so that the last clip in your video fades out to black, go to the Effects panel. 

Drag the Cross Dissolve transition to the end of the video on the Timeline.  

 

Working with Audio Transitions 

Let us look at the audio transitions available in the Effects panel. 

 
Fig43: Available Audio Transition Panel  

NOTE : With both video and audio transitions, the transition highlighted with a yellow border is the 

default transition. 

 

There are three audio transitions available in the Effects panel: Constant Gain, Constant Power, and 

Exponential Fade.  

 

Audio transitions are a lot like video transitions in that you add them the same way, you can change the 

duration, and you can edit them.  

 

Adding an Audio Transition 

To add an audio transition, drag an audio transition from the Effects panel to the intersection of two audio 

clips. Again, as with video transitions, it is best to choose Centre at Cut alignment if possible. 

 

Fig44: Adding Audio Transition 

In the snapshot above, you can see the audio transition between the two audio clips. 
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7.3  Working with Effects 

Adobe Premiere Pro has   various  of effects that you can apply to your clips in your timeline. An effect 

can add a special advantage to your video characteristic. For example, an effect can alter the exposure or 

colour of footage. You can also use effects to rotate and animate a clip or adjust its size and position 

within the frame. You control the intensity of an effect by the values that you set for it. You can also 

animate the controls for most effects using key frames in the Effect Controls panel or in a Timeline panel. 

Adobe Premiere Pro has  mainly two types of effects.  One  is  fixed  effects and the  second is standard 

effects. Every clip you add to a timeline panel has fixed effects pre-applied. Fixed effects control the 

inborn properties of a clip and appear in the Effect Controls panel whenever the clip is selected. You can 

adjust all the fixed effects in the Effect Controls panel.The fixed effects have an effect like Motion, 

Opacity, Volume and  Time Re-mapping. 

Standard effects are additional effects that you must first apply to a clip to create a desired result. You can 

apply any number or combination of standard effects to any clip in a sequence. Use standard effects to 

add special characteristics or to edit your video, such as adjusting tone or trimming pixels. Adobe 

Premiere Pro includes many video and audio effects, which are located in the Effects panel. Standard 

effects must be applied to a clip and then adjusted in the Effect Controls panel. 

You can see the picture below: 

  

 

 

 

 

 

 

7.4  Integration with Other Software 

You can integrate Adobe Illustrator, Adobe Photoshop and Adobe After Effects with Adobe Premiere 

Pro. You can create a myriad of options for creating theatrical, broadcast, and commercial motion pictures 

from Adobe Premiere Pro and Adobe After Effects. Add the availability to import files from Adobe 

Photoshop and Illustrator and the scope broadens even more.  

As Adobe Premiere Pro and Adobe After Effects work similarly, you can work easily on them. You can 

import layered Adobe Photoshop files as flattened clips, or timelines with each layer on a separate track. 

Export projects as AVI and MPEG files for in Adobe Encore DVD, a creative tool for authoring 

sophisticated Multilanguage DVDs. Timeline markers from Adobe Premier Pro become DVD chapter 

points.  

Adobe Photoshop files can be imported in Adobe Premiere Pro. Adobe Premiere Pro import attributes 

that were applied on the original file. Those attributes include position, opacity, visibility, transparency 

(alpha channel), layer masks, adjustment layers, common layer effects, layer clipping paths, vector masks, 

and clipping groups.  

When you import layered Photoshop files in Adobe Premiere Pro, it stores non- flattened empty 

(transparent) areas as an alpha channel. This feature helps you to superimpose the transparent areas over 

clips in other tracks with no extra effort. A file saved or exported with a white background in Adobe 
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Photoshop, imports as opaque white. Files saved or exported as a checkerboard background translate into 

alpha channel transparency in a format that supports alpha channels.  

Apart from this, you can also import  the  layered Photoshop file as a sequence. This allows you to set up 

animations in Adobe Photoshop and then import them into an Adobe Premiere Pro project. When Adobe 

Premiere Pro converts layers to a sequence, the sequence is imported into the Project window as a bin.  In 

the bin, each layer in the file becomes an individual clip and each clip's name consists of the layer name 

followed by the name of the file that contained it. Apart from this, Adobe Premiere Pro automatically 

creates a sequence in which each layer is inserted in order at the default still-image duration. You can use 

this sequence as a clip in other sequences.  

Some layer attributes of Adobe Photoshop, such as non-normal blending modes and the Knockout option  

not supported. Use basic transparency and opacity for best results.  

______________________________________________________________ 

Unit Summary 

In this unit you have learnt about the transitions, how and when to add transitions, how to set a default 

transition and how to add a video transition. You have also come across deleting, replacing, and changing 

the duration of transitions. 

 

We have  explained  applying a video effect, to add the effect on multiple clips, a fade-in to the beginning 

of a video and a fade-out to the end of a video. 

_____________________________________________________________ 

Assignment 

1.  What do you know about the different effects and transitions and how they are used while editing a 

program.   Explain with examples. 

2. What are the different softwares which can be integrated while editing on Adobe Premiere Pro? 

___________________________________________________________ 

Terminology 

Fade In: Cross dissolve transition to the start of the video on the timeline.  
 

Fade Out: Cross dissolve transition to the end of the video on the timeline. 
 

Rendering: The process of applying edits, effects, and transitions to video frames. 
 

Dissolve: A fade from one clip into another clip. 
 

Scrubbing: Shuttling audio or video material forward or backward while previewing. 
 

Clip Speed: Clip speed to a video or audio clip on the timeline to speed up or slow its duration. This 

effect can be especially helpful when you want to show a long process or time lapse. 
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Unit 8 
============================================================ 

Working with Audio 
 

Introduction 
In the last unit you have how to apply video transitions, effects and integrate other Adobe products with 

Adobe Premiere Pro. You also learnt to apply different types of effects and about previewing files. In this 

unit, you will learn about audio, how to create audio fades, panning effects and balance sounds and will 

be able to link and unlink audio with video. Apart from this, you will be able to apply audio transition and 

audio effects after going through the unit.  

After completion of this unit you will be able to: 

Learning Objectives 
 Understand the importance of audio in a video. 

 Learn to apply different audio effects. 

 Work on the different audio tracks. 

 Make an audio link to video. 

 Dubbing or mixing sound tracks. 

8.1  Audio for Video 
A video is not complete without sound. Sound plays an important role in Adobe Premiere Pro. Sounds 

can be edited and effects can be added. You can edit, add effects, and mix up to 99 tracks of audio. You 

can mix mono, stereo, or 5.1 surround audio tracks in Adobe Premiere Pro. Control volume and 

pan/balance settings of audio tracks directly within the Timeline window, or use the Audio Mixer 

Window to make changes in real time. A wide range of built-in controls such as equalization and delay 

effects is also possible in  Adobe Premiere Pro.  

Dubbing, mixing, or re-recording is a post-production process used in filmmaking and video production 

in which additional or supplementary recordings are "mixed" with original production sound to create the 

finished soundtrack. 

After sound editors edit and prepare all the necessary tracks (dialogue, automated dialogue replacement, 

effects, Foley, and music), the dubbing mixer or mixers proceed to balance all the elements and record the 

finished soundtrack. ADR is additional dialogue recording, and looping in which the original actors re-

record and synchronize audio segments. 

 

Fig45: Audio Mixture 
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An Audio Mixer 

The audio mixer window is used to automate, track properties only and not clip properties. 

When you mix audio, the actions preformed are applied at various levels within a sequence. You can 

apply one audio level value to a clip and another value to the track that contains the clip.  You can also 

have a track that is actually a nested sequence, containing volume changes and effects applied to the 

tracks in the source sequence. Values applied at all  these levels will be combined for the final mix.  

Based on the number of channels in the track, and sub-mix tracks, they can be classified into the 

following types:  

Mono (monophonic): It contains an audio clip which can be modified by an effect applied to the clip, and 

an effect applied to the track that contains the clip. You can view and edit the audio settings of any clip or 

track and can use multiple views of the same audio data as mentioned below.  

You can view and edit track volume or effect values both in the Audio Mixer window and in the Timeline 

window. Set the track display to Show Track Key Frames or Show Track Volume. You can view and edit 

clip volume or effect values both in the Effect Controls window and in the Timeline window. Set the 

track display to Show Clip Key Frames or Show Clip Volume. You can have any combinations of mono, 

stereo, and 5.1 surround tracks that can be added or deleted at any time. You cannot change the number of 

channels a track uses after you first created it. A master track is a track that controls the combined output 

for all tracks in the sequence. It is always present in a sequence. 

You can have two kinds of tracks in a sequence. 

Regular Audio Tracks: These tracks contain actual audio.  

Sub Mix Tracks: This track outputs the combined signals of tracks routed to it. They are useful for 

managing mixes and effects . 

Stereo (stereophonic): It contains two channels (left and right).  

5.1: It contains three front channels (left, centre, and right), two rear or surround channels (left and right), 

and   low-frequency effects (LFE) channel routed to a subwoofer speaker.  

Getting to Know the Audio Workspace  

You can select the Audio workspace at any time while working on a project. The Audio workspace uses 

your current workspace with the following adjustments: 

 The Audio Mixer is open and no palettes are displayed.  

 Customize the audio workspace by rearranging the windows and changing their settings.  

 Saving a workspace preserves the locations of the Project, Timeline, and Audio Mixer windows.  

To organize windows for audio mixing, do the following: 

Select Window > Workspace >Audio 

Working with the Audio Mixer Window  

The Audio Mixer window, like a professional sound studio-style audio mixing console, contains a set of 

controls for each audio track. The controls are numbered according to the corresponding audio track in 

the Timeline. This window also contains a volume fader labelled Master, which controls the overall 

volume for the entire project.  
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In addition, in the Audio Mixer window, you can adjust the volume level and pan/balance of multiple 

audio tracks While listening to them and viewing the video tracks, Premiere Pro uses automation to 

record these adjustments, and then apply them as the clip plays back. 

Audio Units: Use this option to display time in audio units instead of video frames. The option affects the 

time displays in the Audio Mixer window, Program window, and Timeline window.  

To specify whether to view audio units or milliseconds, select Project > Project Settings > General 

dialogue  box and change the Display Format option.  

Metre  input(s) only: Use this option to display hardware input levels on the VU metres (not track 

levels). When this option is on, you can still monitor audio in Premiere Pro for all tracks that are not  

being recorded.  

Viewing Audio Clips  

In the Timeline window, you can view an audio clip's Volume, Mute or Pan time graphs and its 

waveform. To set precise In and Out points, you can view an audio clip in the Source view of the Monitor 

window. For editing audio at smaller increments than frames, you can view sequence time in audio units 

instead of frames. 

Adjusting Volume or Gain Levels  

You can set the overall gain, or volume, of a clip. Gain generally refers to the input level, and volume 

generally refers to the output level. Setting the gain is useful for balancing the gain levels of several clips 

or when a clip's audio signal is too high or too low. Keep in mind, that if the gain in an audio clip was set 

too low, when the clip was digitized, then increasing the gain may emphasize noise or introduce 

distortion. Generally sound is recorded or source audio digitized at the optimum level. This allows you to 

concentrate on adjusting track levels. You can control the output level of a selected clip in the Timeline 

window or in the Effect Controls window. Though the Gain command is independent of the level setting 

in the Audio Mixer window and Timeline window, its value is combined with the track level for the final 

mix. Audio Mixer window is the primary window for controlling track levels.   But you can also do the 

same using audio track key frames in the Timeline. Because track key frames represent mixer automation 

settings, they affect output only when automation is set to Read, Touch, or Latch. 

Unlinking and Editing  Audio  

Cross-fading requires audio clips to overlap. Generally audio clips that are linked to video clips do not 

overlap. Thus, cross-fading such audio clips is more complex than an audio-only cross-fade. The audio 

clips linked to video clips cannot be dragged to overlap if the audio clips are on the same track, but you 

can move the audio clips onto different tracks. To move or trim audio and video clips independently they 

need to be unlinked.  

Cross-fading audio linked to video is useful when performing a split edit. In split edit, a clip's video and 

audio components start or end at different times. You can perform an L-cut or J-cut type of split edit. In 

L-cut, the audio Out point is later than the video Out point.  So that you can continue playing a video 

clip's audio after the next video clip's In point. Use J-cut, when you want an audio/video clip's audio to 

start playing before the video In point,  

When you want to cross fade existing clips in the Timeline window, you have to extend the duration of 

one or more audio clips. Whenever you extend the duration of a clip, additional frames must be available 

in the clip's source (master) clip beyond the current In or Out point. 
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Panning and Balancing  

You can pan a monophonic audio track to set its position in a multichannel track. You can balance a 

multichannel (stereo or 5.I) audio track, to redistribute its channels among the channels of another 

multichannel track. Balancing is distinct from panning in that spatial information is already encoded in 

multiple channels; balancing simply alters their relative proportions.  

If you find that the track balancing is not sufficient, only then balance a clip by applying the balance 

audio effect.  

When you pan or balance an audio, you must know its availability. The availability is not defined by an 

audio track by itself, but rather by comparing the number of channels in the track with the number of 

channels in its output track. The number of channels for that track is shown by the number of level metres 

in a track in the Audio Mixer window. The output track name is visible at the bottom of each track in the 

Audio Mixer window.  

You can pan an audio track when you output a mono track to a stereo or 5.1 surround track. You can 

balance an audio track when you output a stereo track to a stereo or 5.1 surround track. Premiere Pro 

down mixes the audio to fit it within the smaller number of channels, when the output track contains 

fewer channels. 

 Panning and balancing are not available when both tracks are pono or both tracks are 5.1 surround. The 

channels of both tracks correspond directly.  

Breaking Out Channels in an Audio Clip  

You can separate a clip's stereo or 5.1 surround audio tracks into multiple mono clips, using the Breakout 

to Mono Clips command on a clip selected in the Project window.  

Breaking out Channels Can Cause the Following:  

 Breaking out a stereo clip: Results in two mono audio clips - one for each channel.  

 Breaking out a 5.1 surround clip: Results in six mono audio clips - five channels plus the LFE 

channel.  

 Breaking an audio clip that is linked to video: Produces a video track with no audio. The original clip 

is always preserved.  

To Break Out the Channels in an Audio Clip:  

 Import a stereo or 5.1 surround audio clip.  

 In the Project window, select the clip.  

 Select Clip> Audio Options > Breakout to Mono Clips.  

After breaking audio clips, the resulting files are labelled with their original channel names. These are 

then added to the end of the new file names. 

Treating a Mono Audio Clip as Stereo Clip  

You would often want to use a mono audio clip as a stereo clip as it is very useful. The Treat as Stereo 

command applies a mono clip to a pair of left and right stereo channels. Make sure you use the Treat to 

Stereo command on a mono clip in the Project window before adding it to a stereo track in the Timeline 

window. A clip instance cannot be converted to stereo when it is used in a mono audio track. Use the 

Treat as Stereo command on an instance of the clip in the Project window, and then drag it to a stereo 

track. 
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Automating Audio Changes in the Audio Mixer Window  

In Premiere Pro, you can apply changes to an audio track's settings as a sequence plays back using 

automation. Automation can be done for the volume, pan, and mute settings of a track. For track effects, 

you can automate all effect properties, including the bypass setting.  

All the automation modes such as Read, Touch, Write, or Latch, are set in the pop-up menu at the top of 

each track. When automation is set to any of these modes during playback, Premiere Pro plays back the 

track with the automated adjustments. As you make adjustments in the Audio Mixer window, Premiere 

Pro applies your changes by creating track key frames in the Timeline window. Track key frames that you 

add or edit in the Timeline window automate values in the Audio Mixer window (such as fader positions) 

as the audio plays back.  

The following are the automation options in the pop menu at the top of each track:  

Off: This option reads the track's stored settings during playback. It allows real-time use of Audio Mixer 

controls without interference from stored automation settings.  

Read: This option reads the track's automation settings and uses them to control the track during 

playback. Adjusting a track option (such as volume) affects the entire track uniformly if a track has no 

settings. If you adjust a property for a track set to Read automation, then when you stop adjusting it, the 

value returns to where it was before the current automated changes were recorded.  

Write: This option records adjustments made to any automatable track settings that are not set to Safe 

During Write, and creates corresponding track key frames in the Timeline window. This mode writes 

automation as soon as playback starts, without waiting for a setting to change. Modify this behaviour 

using the Switch to Touch After Write command in the Audio Mixer window menu. When Switch to 

Touch After Write command is on, all tracks set to Write mode switch to Touch mode after playback 

stops or a playback loop cycle completes. 

Latch: This mode is similar to Write, except that automation does not start till  you begin to adjust a 

value and the value remains where it was when you stopped adjusting it.  

Touch: This option is similar to Write, except that automation does not start till  you begin to adjust a 

value. When you stop adjusting a property, its value returns to where it was before the current automated 

changes were recorded. 

If you want to alter automation settings for some properties while leaving other properties unchanged, use 

Safe During Write command on the context menu. This option prevents that property from being edited 

when Write automation mode is on. When you set a property to Safe During Write, that property is 

protected across all tracks in a sequence. 

 

8.2  Applying Audio Effects 
In Adobe Premiere Pro, audio effects are in the Effects window, inside the Audio Effects bin. According 

to the audio, select the effect from within the bin (5.1, Stereo and Mono) named for the number of 

channels in the track where you want to apply the effect.  

Audio effect can be applied and edited in the same way that video effects are applied and edited to video 

clips. 

To apply audio effects to audio, the following steps should be taken:  

1.   Import an audio clip.  

2.   Place the audio clip in the Timeline window.  

3.   In Effects palette, open the Audio Effects folder.  
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4.   Open 5.1, Stereo or Mono folders according to the audio chosen. 

5.   Select the effect you want to apply on the audio.  

6.   Drag an effect to the audio clip in the Timeline window. 

Audio Effects 

The following are the audio effects in Adobe Premiere Pro: 

5.1: Bandpass, Bass, Channel Volume, De Nosier, Delay, Dynamics, EQ, Highpass, Invert, Lowpass, 

Multiband Compressor, Multitap Delay, Notch, Parametric EQ, Pitch Shifter, Reverb, Treble, Volume.  

Stereo: Balance, Bandpass, Bass, Channel Volume, DeNosier, Delay, Dynamics, EQ, Fill Left, Fill 

Right, Highpass, Invert, Lowpass, Multiband Compressor, multitap Delay, Notch, Parametric EQ, Pitch 

Shifter, Reverb, Swap Channels, Treble, Volume. 

Mono: Bandpass, Bass, De Nosier, Delay, Dynamics,  EQ, Highpass, Invert, Lowpass, Multiband 

Compressor, Multitap Delay, Notch, Parametric EQ, Pitch Shifter, Reverb, Treble, Volume. 

Balance: With this effect you can control the relative volumes of the left and right channels. If you use  

positive values, Adobe Premiere Pro increases the proportion of the right channel. If you use  negative 

values, Adobe Premiere Pro increases the proportion of the left channel. This effect can be applied to 

stereo clips only.  

Bass : You can increase or decrease lower frequencies (200 Hz and below) using the Bass effect. With 

the Boost option, you can specify the number of decibels to increase the lower frequencies.  

Treble: You can increase or decrease higher frequencies (4000 Hz and above) using the Treble effect. 

With the boost option, you can specify the amount, measured in decibels, to increase or decrease higher 

frequencies.  

Delay: With the Delay effect, you can add an echo to an audio clip. The echo plays the audio clip's sound 

after a specified amount of time. The Delay option lets you specify the amount of time before the echo 

plays. The maximum is 2 seconds. The feedback option specifies a percentage of the delayed signal to be 

added back into the delay to create multiple delaying echoes. The Mix option controls the amount of 

echo.  

Parametric EQ: You can increase or decrease frequencies near the specified centre  frequency using the 

Parametric Equalization effect. The centre option lets you specify the frequency at the centre  of the 

specified range. The Q option lets you specify the range of frequencies to be affected. A low setting 

creates a narrow band; a high setting creates a wide band. The amount by which frequencies are adjusted 

is set in decibels by the Boost parameter. The Boost control specifies how much to adjust the specified 

Width in decibels. The Boost option specifies the amount to increase or decrease the range of frequencies 

(between -20 and +20 dB).  

Reverb: By simulating the sound of the audio playing in a room, the reverb effect adds ambience and 

warmth to an audio clip. The time between the signal and the reverberation is specified by the PreDelay 

option. This setting correlates to the distance a sound travels to the reflecting walls and back to the 

listener in a live setting.  You can use the graphical controls in the Custom Setup view, or adjust values in 

the Individual Parameters view. The Absorption option specifies the percentage in which the sound is 

absorbed. The Size option specifies the size of the room as a percentage. The Density specifies the density 

of the reverb "tail". The Size value determines the range in which you can set Density. The Lo Damp 

option specifies the amount of dampening for low frequencies (in decibels).  
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_______________________________________________________________ 

Unit Summary 

In this unit you have learnt to mix mono, stereo, or 5.1 surround audio tracks in Adobe Premier pro. In the 

Audio Mixer window, the controls are numbered according to the Timeline. In the Timeline window, you 

can view an audio clip's Volume, Mute, or Pan time, graphs and its waveform. 

 

You were briefed about the Audio Mixer window where you can adjust the volume level and pan/balance 

of multiple audio tracks while listening to them and viewing the video tracks and also set the overall gain, 

or volume, of a clip. Applying audio fades to audio clips using transitions like cross-fading audio linked 

to video is useful when performing a split edit.  

 

You also came to know that in Adobe Premiere Pro, Audio effects are in the Effects window, inside the 

Audio Effects bin and you can apply changes to an audio track's settings as a sequence plays back using 

automation. 

 

____________________________________________________________________________________ 

Assignment 

1. How do you apply the audio effects? Explain. 

2. What do you understand by balance? 

____________________________________________________________ 

Terminology 

AAC Audio: AAC Audio is audio that is compressed using Advanced Audio Coding 

technology. This is the audio component of most H.264 files. 

 

Mono:  Mono (monophonic): It contains one channel audio. 

 

Stereo: Stereo (stereophonic): it contains two channels (left and  right) 

 

5.1: It contains three front channels (left, centre  and right), to rear or surround 

channels (left and  right), and a low frequency effects (LFE) channel routed to a 

subwoofer speaker. 

 

MP3 Audio :  MPEG-1 Audio Layer 3. Both a compression standard and a file format for 

digital audio. 

 

Audio Sample rate:  The number of samples taken per second to reproduce audio digitally. The higher 

the sample rate, the higher the quality of the digital audio. A rate of 44,100 

samples per second produces CD-quality audio and captures the range of human 

hearing. 

 

Dolby Digital: Standard lossy audio format for DVD video. Supports mono and stereo audio, but 

are most commonly used to compress 5.1 surround sound with the AC-3 codec. 
 

Peak File:  A cache file that contains the waveform image of an audio file. Peak files allow a 

program to open, save, and redraw audio files more quickly because the program 

does not have to re-read the waveform data each time it opens or displays an 

audio file. Peak files can be deleted without affecting the original audio files. 

 

Audio Mixer: The Audio Mixer window is used to automate track properties. 
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Unit 9 
============================================================ 

Superimposing and Compositing 

 
Introduction 

In this unit you will learn about compositing and also how to superimpose clips using keys and mattes. 

In the adobe family there is individual software for visual effect (VFX) called Adobe after effect, but you 

can do the basic VFX like green screen, matte and other things very easily with Adobe Premiere Pro. 

To obtain layered effects that depend on transparency levels of clips in Adobe Premiere Pro, opacity 

adjustments are made in tracks above the Video 1 track. This is called superimposing. 

After completing  of this unit you will be able to: 

 

Learning Objectives 
 Make use of the title window. 

 Add, select, move, navigate, and delete key frames. 

 Understand  the superimposing and  compositing techniques. 

 Explain the colour management and colour correction. 

 

9.1  Key Frames, Opacity and Superimposing 
 

 

 

 

 

Superimposing (often called matting or keying in television and film production) means playing one clip 

on top of another. In Adobe Premiere Pro, you can add clips to the superimpose tracks (Video 2 and 

higher). Then you can add opacity or fades so that the clips placed in lower tracks in the timeline appears 

partially as well. If you do not apply opacity to the clip in the highest track, the clips directly below will 

not appear when you preview or when you play your final movie. 

Adobe Premiere Pro provides a broad variety of keys (methods for creating opacity) that allow you to 

vary the type and intensity of opacity applied to different areas of a clip. When superimposing, you can 

designate matte(specified area) to be totally transparent, or you can apply opacity based on a colour or 

colour quality, such as brightness.  

Compositing is defined as combining two images in a scene and making it appear as if they were shot 

together.  

 

Keying is also known as green screening. It involves replacing a colour in an image with parts from a 

background image. 

Shooting a scene against a colour screen often creates special effects for film or video. After the footage 

is digitized, the colour screen is then made transparent with a key. The first scene or a clip is placed over 

Watch this video on using different tools during 

video editing at goo.gl/CFMwEi 

 

https://goo.gl/CFMwEi
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a second clip, which usually includes some sort of background scene. The result forms a composite, 

where the background is visible wherever the first clip is transparent, making the first clip appear to 

belong with the background. 

Composites are often used in movies where, for example, an actor/actress is shown at the edge of a 

mountain rock. In this case, the actor/actress is shot in an appropriate position against a colour screen, and 

after making the colour transparent, the actor's scene is superimposed over the backdrop. Colour screens 

are usually blue or green because these colours are relatively absent from skin or hair colour. 

 

Matte or Mask  
Matte or Mask is an image that indicates transparent or semi-transparent areas for another image. When 

you are super imposing an object in one clip over the background of another clip, use a mask to remove 

the background of the first clip. Create a still-image or moving (travelling) matte using another still-

image, or motion graphics software, and apply it to a clip in your Adobe Premiere Pro project. Just like a 

film negative, a mask works in a similar manner, black areas are transparent, white areas are opaque, and 

grey areas are semi-transparent — darker areas are more transparent than lighter areas. Use shades of grey 

to create feathered (soft-edged) or graduated masks. 

 

Alpha Channel 

Colours in an RGB video image are  stored in three colour channels, i.e. red, green and blue. Apart from 

this, an image can contain a fourth channel called alpha channel. Keeping an image together with its 

mask saves you the trouble of managing two separate files. However, if you create  a track matte effect, a 

separate file for a mask is helpful, as it must be placed in a separate track in Adobe Premier Pro.  

 

Keying 

Keying is finding specified matching colour or brightness pixels and making those pixels transparent or 

semi-transparent. For example, if you have a clip of weatherman standing in front of a blue screen 

background, you can key out the blue and replace it with a weather map.  

 

Opacity 

Opacity allows you to control the degree of overall transparency for a clip. Use opacity to fade a clip in or 

out. The opacity of a clip or portion of a clip determines its level of transparency. At 100% opacity, an 

image contains no transparency at all, at 0% opacity, the image is completely transparent, allowing other 

clips to show through. At other percentages, the image is partially transparent, allowing other underlying 

images to be visible at the same time.  

 

Fading 

In addition to making portions of a clip transparent with keys, you can also adjust the opacity of the entire 

clip to fade in or fade out. You can use fading to create additional transitional effects or to create simple 

superimposing.  

 

9.2  Chroma Key Options  
Chroma key is used to select a colour or a range of colours in the clip to be transparent. You can use this 

key for a scene shot against a screen that contains a range of one colour, such as a shadowy blue screen. 

To select a key colour, click the colour swatch or by drag the eye dropper to a colour in the Monitor 

window. Release the mouse button only when the eyedropper is over the colour you want, as indicated by 

the swatch next to the eyedropper.  
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Adjust the following Chroma key settings as necessary:  

Similarity: This option broadens or reduces the range of colour that will be made transparent. Higher 

values increase the range.  

Blend: This option blends the clip you are keying out with the underlying clip. Higher values blend more 

of the clip.  

Threshold: This option controls the amount of shadows in the range of colour you keyed out. Higher 

values retain more shadows.  

Cutoff: This option darkens or lightens shadows. Drag to the right to darken shadows, but do not drag 

beyond the Threshold slider; doing so inverts grey and transparent pixels.  

Smoothing: This option specifies the amount of anti-aliasing that Adobe Premiere Pro applies to the 

boundary between transparent and opaque regions. Anti-aliasing blends pixels to produce softer, smoother 

edges. Choose None to produce sharp edges, with no anti-aliasing. This option is useful when you want to 

preserve sharp lines, such as those in titles. Choose Low or High to produce different amounts of 

smoothing.  

Mask Only: This option displays only the clip‘s alpha channel, as modified by the key settings. 

9.3  RGB Difference Key Options 
You have seen the Chroma key earlier. The RGB Difference key is a simpler version of the Chroma key.  

With RGB Difference key you can select a range of colour.    However, you cannot blend the image or 

adjust transparency in grey. This key is useful for a scene that is brightly lit and contains no shadows, or 

for rough cuts that do not require fine adjustments. Select a key colour by clicking the Colour swatch or 

by dragging the eyedropper to a colour in the Monitor window. Release the mouse button only when the 

eyedropper is over the colour you want as  indicated by the swatch next to the eyedropper. 

Adjust the following RGB Difference key  settings as necessary: 

Similarity: This option broadens or reduces the range of colour that will be made transparent. Higher 

values increase the range.  

Smoothing: This option specifies the amount of anti-aliasing (softening) that Adobe Premiere Pro applies 

to the boundary between transparent and opaque regions. Choose  None to produce sharp edges with no 

anti-aliasing. This option is useful when you want to preserve sharp Iines, such as those in titles. Choose 

low or high to produce different amounts of smoothing. 

Mask Only: This option displays only the clip‘s alpha channel as modified by the key settings.  

Drop Shadow: This option adds a 50% grey, 50% opaque shadow offset from the opaque areas of the 

original clip image by four pixels down and to the right. This option works best with simple graphics such 

as titles.  

Blue and Green Screen Options 

Use Blue Screen and Green Screen keys to create transparency from true chroma blue and true chroma 

green. Use these keys to key out well-lit blue or green screens when creating composites. 

Adjust the following Blue Screen and Green Screen key settings as necessary: 
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Threshold: Use this option to drag to the left till  the blue or green screen is made transparent  

Cutoff: Use this option to drag to the right till the opaque area reaches a satisfactory level.  

Smoothing: This option specifies the amount of anti-aliasing (softening) that Adobe Premiere Pro applies 

to the boundary between transparent and opaque regions. Choose None to produce sharp edges, with no 

anti-aliasing. This option is useful when you want to preserve sharp lines, such as those in titles. Choose 

Low or High to produce different amounts of smoothing.  

Mask Only: This option displays only the clip's alpha channel, as modified by the key settings. 

Drag Threshold and Cutoff Sliders in Small Increments to Fine-Tune Edges. 

Non Red Key Options 

Use Non Red key to create transparency from green or blue backgrounds. It is similar to the blue screen 

and green screen keys, but it also lets you blend two clips. In addition, it helps reduce fringing around the 

edges of non-transparent objects. Use the Non Red key to key out green screens when you need to control 

blending, or when the Blue Screen or Green Screen key does not  produce satisfactory results.  

Adjust the following settings as necessary:  

Threshold: Use this option to drag to the left till  the blue or green screen is made transparent.  

Cutoff: Use this option to drag to the right till  the opaque area reaches a satisfactory level.  

Defringing: This option removes residual green or blue screen colour from the edges of the opaque areas 

of a clip. Choose None to disable defringing. Choose green or blue to remove a residual edge from green-

screen or blue-screen footage respectively.  

Smoothing:  This option specifies the amount of anti-aliasing (softening) that Adobe Premiere Pro 

applies to the boundary between transparent and opaque regions. Choose None to produce sharp edges, 

with no anti-aliasing. This option is useful when you want to preserve sharp lines, such as those in titles. 

Choose Low or High to produce different amounts of smoothing. 

Mask Only: This option displays only the clip's alpha channel, as modified by the key settings. 

Luma Key Options 

Luma key is used to create a subtle superimposition or to key out dark areas.  

Adjust the following settings as necessary:  

Threshold: This option specifies the range of darker values that will become transparent. Higher values 

increase the range of transparency.  

Cutoff: This option sets the opacity of areas that have been Specified by the Threshold slider. Higher 

values increase transparency. 

Set Threshold to a low value and Cutoff to a high value to key out light areas. 

Multiply and Screen keys Options 

The multiply and Screen keys use an underlying image as a map to determine what part of the keyed 

image to make transparent. The Multiply key creates transparency in the areas of the image that 
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correspond to the bright areas in the underlying image. Conversely, the Screen key creates transparency in 

the areas that correspond to the dark areas of the underlying image. Like the Luma key, the Multiply and 

Screen keys are most effective when the image that you are keying contains highly contrasting dark and 

light areas. Use these keys to create a subtle superimposition, when the underlying image contains highly 

contrasting elements.  

Adjust the following settings as necessary:  

Opacity: Use this option to drag to the right till  the opacity of the effect reaches a satisfactory level. 

Higher values produce less transparency.  

Cutoff: Use this option to drag to the right till  the opaque area reaches a satisfactory level. Higher values 

produce less transparency.  

 

9.4  Using Matte Keys 
A matte is an image that specifies transparent or semi-transparent areas for another image. You can use 

matte keys to add travelling mattes or creative superimpositions.  

Image  Matte Keys: The Image Matte key defines the areas of transparency for a clip by using a matte 

image's alpha channel or brightness values, To get the most predictable results, choose a grey scale image 

for your image matte, unless you want to alter colours in the clip. Any colour in the image matte removes 

the same level of colour from the clip you are keying. For example, white areas in the clip that correspond 

to red areas in the image matte appear blue-green (since white in an RGB image is composed of 100% 

red, 100% blue, and 100% green); because red also becomes transparent in the clip, only blue and green 

colours remain at their original values. 

Adjust the following Image Matte settings as necessary:  

Setup: Click to select an image. Portions of the clip in the track that correspond to the white areas of the 

image are superimposed on clips in lower tracks. 

Composite Using: Select matte Alpha to composite using the values in the alpha channel of the image 

you selected using the Setup button. Select Matte Luma to composite using the image's luminance values 

instead.  

Reverse Key: Click to reverse transparency. Portions of the clip in the track that correspond to the black 

areas of the image are superimposed on clips in lower tracks. 

9.5  Colour Management and Correction 
The colour correction features in Adobe Premier Pro give video editors precise controls for monitoring 

colour from clip to clip. Adobe Premier Pro provides built-in waveforms and vectorscopes to ensure that 

your colour adjustments are within the legal broadcast limits.  

By default, the source and program views display video, as it would ordinarily appear on a video monitor. 

However, you can also display the video's alpha channel, or transparency information. In addition, you 

can evaluate the video's brightness and colour by running several iterations of measurements and 

displaying them with Vectorscope or a Waveform Monitor.  
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9.6  Creating Titles 

Working with Adobe Title Designer text and graphics play an integral role in conveying information in a 

video program. With the Adobe Title Designer you can create text and graphics that you can import and 

superimpose over existing video or run alone as an independent clip.  

 

Adobe Premiere Pro Title Designer has many text and  graphic tools for developing a vast variety of 

designs, whether they are static, rolling or crawling.  

 

With Title Designer you are able to create broadcast-quality title sequences that include text and graphic 

elements. The following time saving features in Adobe Premiere Pro Title Designer help you to craft  a 

highly designed opening sequence that combines text and graphic elements with moving footage.  

 

Professional typographic controls leading, kerning, baseline shift, rotation, slant, and many more, mean 

that you can refine your titles with the precision of Adobe Illustrator text. You can also apply special edge 

treatments such as outlined text, embossing, or bevels to help a title pop off the screen.  

 

Drawing tools, including the Adobe-standard pen tool is used to draw free-form vector shapes that range 

from simple to complex forms, or you can also use other drawing tools to create simple regular shapes 

such as circles, polygons, rectangles and lines.  

 

Styles for text and shapes work with pre-defined text and object styles or you can create your own custom 

styles. Styles are easy to manage and you can also save and load styles from other title projects. 

Timesaving Templates  

Customize your own templates or modify the over 100 templates included with Adobe Premiere Pro to 

create customized looks. 

Precise Animation Control 

Once the titles are formatted, you can add motion by using either the roll or crawl options in the Adobe 

Title Designer or by animating the complete title file in the Premiere Timeline.  

 

Fig46: Title Designer Workspace 

Watch this video on using different tools during 

video editing at goo.gl/f1Vpdo 

 

 

 

https://goo.gl/f1Vpdo
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Adobe Title Designer Window Workspace 

Adobe Title Designer can be used for adding titles as well as logos. You can also add rolling and crawling 

text. A title to a project  can be added in the following manner:  

Adding a New Clip:  

 A new title clip can be added to a new or existing project.  

 Open a new or existing project for which you want to create a new title clip. Use the Titler to create 

the title. Give a name and save the new title file. When you save the new title, Premiere automatically 

adds it to the project and lists it in the Project window. Remember to save the project in order to keep 

the title with the Project.  

 

 Open a new (untitled) project and use the Titler to create a new title. When you save the new title 

clip, Premiere automatically adds it to the new (untitled) project. Close the untitled project without 

saving.   The  new title clip will be available for use in any project because you have named and 

saved the title file.  

 

Title Type Pop-Up Menu: Choose to make still, rolling, or crawling titles. 

Tools: A wide variety of text,  vector and bitmap graphics tools are provided.  

Title Area: The Title area is your canvas for creating with the Title Designer.  

Title-Safe Zone: All monitors, TVs, or displays do not have the same viewing area. In the title designer 

you have two white-line boxes bounding the main title work area. The inner box is the title-safe zone and 

the outer box is the action-safe zone. Placing key elements inside the safe zones ensures  that they will be 

easily visible on virtually any kind of  viewing screen. Text placed outside the title-safe zone may appear 

blurry or distorted on some television monitors. Graphic images beyond the action-safe zone may not be 

visible on some television monitors. You can turn these margin lines on or off by selecting Title > View. 

Font Styles Area: Adobe Premiere Pro comes with more than 90 high quality Adobe Postscript (Type 1) 

and Open Type fonts chosen specifically for their legibility in video. These fonts also work well with 

print and web design.  

Font Styles Options  Pop-Up Menu: Add, modify, and save font styles.  

Transform Area: Is where you can move, rotate, change opacity, and scale objects in the Title Designer.  

Object Style Area: In this you can modify colours, adjust properties, and the appearance of objects in the 

Title Designer. The properties in this area change depending on the selected object. Map textures onto 

text, apply multi-coloured gradients, emboss or bevel edges, make subtle drop shadows, and modulate 

transparency.  

Templates Pop-Up Menu:  You can choose from over 200 pre-designed broadcast-quality title sequence 

templates, including still layouts, rolls, and crawls. Alternatively, you can create your own templates and 

styles, and save and share them.  
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______________________________________________________________ 

Unit Summary 
 

In this unit, you were briefed about compositing and superimposing clips using different keys and mattes. 

You also learnt about how  opacity  controls the degree of overall transparency for a clip. Colour 

Management and Colour Correction were also explained. 

 

You were also told  how Adobe Title Designer text and graphics play an integral role in developing a vast 

variety of designs for creating titles. 

_______________________________________________________________ 

Assignment 
1. What do you understand by superimposing? Explain by giving an example. 

2. How do you manage to do colour correction in Adobe Premiere Pro? 

3. How can Adobe Title Designer be used for creating /adding titles in a project?                            

 

_______________________________________________________________________________ 

Terminology 
 

MATTE:   Matte or mask is an image that indicates transparent or semi-transparent areas for 

another image. 
 

CHROMA:  Chroma keying is a special effects  technique for compositing (layering) two 

images or video streams together based on colour hues. 
 

KEY FRAMING: Key framing is a standard technique to change an effect over time. 
 

DROP SHADOW: This option adds a 50% grey, 50% opaque shadow offset from the opaque areas 

of the original clip image by four pixels down and to the right. This option works 

best with simple graphics such as titles.  
 

SMOOTHING:  This option specifies the amount of anti-aliasing (softening) that Adobe Premiere 

Pro applies to the boundary between transparent and opaque regions. 
 

CUTOFF:  This option sets the opacity of areas that have been specified by the threshold 

slider. Higher values increase transparency. 
 

THRESHOLD:  This option specifies the range of darker values that will become transparent. 

Higher values increase the range of transparency. 
 

TITLE AREA:  The title is your canvas for creating with the title designer. 
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Unit 10 
============================================================ 

Rendering and Exporting the Video 

Introduction 
In this unit you will learn the final element of video editing i.e. render and  export. All video editing 

softwares  have  a feature called Video render. Render is the final stage of film editing. Adobe Premiere 

Pro offers you several pre-configured export settings (called destinations) that allow you to export your 

project such as a MPEG-4 to AVI, QuickTime Movie, as well as to Apple devices, Facebook, YouTube, 

and so on. 

After completion of this unit you will be able to: 

Learning Objectives 

 Render and export video. 

 Work on Adobe Media Encoder. 

 Use different steps involved while exporting the final output. 

 

10.1 Render and Exporting Video  

Rendering in video editing is the computer process of combining your still pictures, video clips, audio 

clips and other visual elements into a single digital video frame.  

When you render your video in your video editing software you are combining different elements such as  

video clips, still pictures, audio and special effects into one file and format.  

Generally, as you edit you can do a preview in real-time (un-rendered) that will look pretty much like 

what you are going to see in the finished video.  Hoever,  if it is a more complex video where you have 

layered in many  special effects, several tracks of video and audio clips and complex cuts etc. then real-

time playback is much more difficult for the computer no matter how fast it is. It is for you to see a real 

representation of what the video will look like in its finished state.  You will need to render the whole 

video. 

Watch this video on using different tools during 

video editing at goo.gl/Gkz7FQ 

 

https://goo.gl/Gkz7FQ
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All the layers of effects, video footage, still pictures, audio clips, cuts, etc. have to be rendered. Once a 

file is rendered it does not need to be re-rendered unless changes are made.  

In most video editing softwares there will be an indicator on the video editor's timeline view which 

indicates if the footage has been rendered or not. For example in Adobe Premier Pro there will be a green 

line across the top of frames in the timeline that have been rendered. Frames that have been changed or 

edited in some way will have a red line across the top so that you know that those frames have not been 

rendered and saved yet. 

10.2  Exporting Video 

 
Fig47: Exporting window 

Exporting Video and Still Image after assembling and editing clips in sequences you can generate the 

final video. The options you choose when producing the final video depends on how it will be used. To 

create motion-picture film from an Adobe Premiere Pro project, you must have the proper hardware for 

video or film transfer or have access to a service provider that offers the appropriate equipment and 

services.  

 

Exporting using Premiere Pro 

Once you finish creating and editing your video, you have several choices as to how you will export it 

from Premiere Pro. You can export editable video or audio files from Premiere Pro, then continue to edit 

them in another program. In addition to exporting the video and/or audio files, you can also export a 

sequence of a single clip or frame. You can also export your video to share with audiences. 

Exporting Images 

You can export a single frame of your video if you want.   This can be helpful if you want to create a 

DVD cover or share a frame you are especially proud of with family and friends.  

To export a frame: 

 Go to the Source Monitor or Program panel.  

 Move the playhead to the frame that you want to export. 
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 Click Export Frame, as circled below. 

 

 
 

You will then see the Export Frame dialogue box: 

 
Fig48: Export Frame dialogue box 

Choose a name for the frame, then select an image format.  In addition, click the Browse button to choose 

the location where you will save the frame.  

 

Check the Import Into Project box if you want the frame imported into the project as an image. 

Click OK when you finish. 

 

We exported our frame as a JPEG. Once we exported it, we located the file and opened it with Windows 

Photo Viewer. As you can see from the title bar (at the top) the frame is now a JPEG. 
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Exporting Media 

You can also export audio and video from Premiere Pro. This includes clips and sequences that you can 

export from either the Project panel or the Timeline.  

 

To export media in Premiere Pro, click the video you want to export in the Project panel or click the 

sequence in the Project panel or Timeline. 

 

Next, go to File>Export>Media. 

You will then see the Export Settings dialogue box, as pictured below. 

 
Fig 49: Exporting Media 

The Export Settings dialogue box is where you will choose a format for your video, as well as the preset. 

The first thing you will need to determine is the format of your video once it is exported, then a 

preset. Always choose a format before you choose a preset.  
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Fig 50: Export Setting window 

 Check the appropriate box if you want to export video and/or audio. 

 Below Export Video and Export Audio, you will see tabs. 

Let  us review a few of these: 

 The Audio tab contains audio encoding options.  

 Captions provide export options for captions. This will be greyed out if you do not have closed 

captions in your video. 

 The FTP tab lets you upload your encoded files to an FTP site. You will need your FTP credentials in 

order to do this. 

At the bottom of the Export Settings dialogue box there are four checkboxes: 

 Maximum Render Quality will enable a higher level of rendering that will improve quality. 

 Frame Blending should be checked if you are going to change the frame rate from the source file to 

the output. 

 Previews allows you to use previews that were produced during editing as the output file. 

 Import into Project will enable Premiere Pro to import the encoded video back into the project. 

When you finish,  click Export or Queue.  

If you choose Queue, Adobe Media Encoder opens.    

Your project is added to its queue. 

If you choose Export, Adobe Media Encoder renders and exports your project right away. 

10.3  Export Formats 
Let  us talk  more about formats before we move forward.  

Take a look at the Export Settings dialogue box again. 

Click the dropdown arrow beside AVI to see the formats available. If you are producing a video for a  

website or for a certain purpose, you may already know what format is required. Otherwise, you will have 

to select a format on your own. We will give you a brief rundown of the formats available. 
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 AAC Audio is audio that is compressed using Advanced Audio Coding technology. This is the audio 

component of most H.264 files. 

 AIFF stands for Audio Interchange File Format. It is an audio only format that is used by OS-X. 

 DNxHD MXF OP1a . This is generally used to export for import into an Avid project or to create an 

extremely high quality archival file. 

 DPX, or Digital Picture Exchange, is for digital intermediate and special effects. 

 F4V and FLV is flash video using the codes H.264(F4V) and VP6 (FLV) codecs.  

 H.264 is the most used distribution codec. Presets for this include mobile, Apple TV, Roku, and other 

box platforms and will encode for YouTube and Vimeo. 

 H.264 Blu-ray for Blu-ray disc. 

 JPEG exports a series of JPEG-compressed frames.  

 MP3 creates an .mp3 audio file. 

 MPEG2 is an older format that can still be used for output for some broadcasters. 

 MPEG2 Blu-ray/DVD should be used for inclusion on Blu-ray or DVD discs. 

 MPEG4 is for old mobile devices. 

 MXF OP1a is for Sony's IMC and some XDCAM cameras. 

 P2 Movie is compatible with P2 cards. 

 PNG creates a series of PNG-compressed frames(Images). 

 QuickTime is good for accessing QuickTime-based codecs, including ProRes. 

 Targa and TIFF will create Targa or TIFF frames. 

 Waveform Audio is uncompressed audio. 

 Windows Media creates a .wmv file. 

Exporting a Master Copy 
A master copy is a copy of your project that you can archive for future use. It is fully editable and 

contains the highest resolution, as well as quality. In addition, it can be used to produce other output 

formats at a later date.  You can use a master copy to produce other output formats as well. 

To create a master copy, go back to the Export Settings dialogue box. 

Put a checkmark beside Match Sequence Settings, as circled below. 
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Next, click the yellow hypertext to select a location where the master copy will be stored. 

 
Fig51: Save Dialogue box 

Click the Save button. Now, look at the Summary area to make sure that the output format matches the 

settings for the sequence. 
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When you finish, click the Queue button. 

10.4  Working with Adobe Media Encoder 

When you click the Queue button in Premiere Pro, Adobe Media Encoder will open up. 

Adobe Media Encoder helps to create your video for whatever screen size and resolution you need and 

offers tools to allow you to publish your video across different browsers and devices. In addition, when 

you export a file from Premiere Pro, Adobe Media Encoder can encode that single file to multiple outputs 

– all at the same time. It can also set up watch folders. 

Let  us take a look at Adobe Media Encoder: 

 
Fig52: Media Encoder Window 
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Adobe Media Encoder has four windows: 

 Queue is in the upper left corner. It lists the files that are in the queue for coding.   

 The Preset Browser is in the upper right hand corner. It contains the same presets as the Export 

Settings dialogue box in Premiere Pro. However, they are in different folders. 

 The Encoding Window is on the bottom left.    

 It will tell you if there are problems with the encoding. 

 Watch Folders  are  located on the bottom right. This contains watch folders that you have 

created. 

Setting Your Preferences 

To set preferences, go to Edit>Preferences. 

Go to the General tab. 

 
Fig53: Preferences Window for setting preferences 

If you do not want to manually start each queue, make sure "Start queue automatically when idle for" is 

checked. 

You can also disable parallel encoding, which is encoding to multiple outputs. If you have a slower 

machine, you may want to disable this. 

In addition, you can select a file location for all encoded files.   If you do not, they will be stored with the 

source video clip. 

Starting an Encoded Queue 

To start an encoded queue, click the Start Queue button in the Queue window, as circled below. 



 Page 100 
 

 

Fig54: Starting an Encoded Queue 

 

Adding Presets to Queued Files 

To add a preset to a queued file, go to the Preset Browser. Find the preset that you want, then drag the 

preset onto the queued file.  

You can add as many as you want. The queued files will be encoded to the selected outputs. 

After you do that, start encoding. 

About Watch Folders 

Watch folders are folders on your hard disc that are tied to presets. You can encode a file to all the presets 

contained in the folder.  

To create a watch folder, go to the Watch Folders window, then click the Add Folder icon. 
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You will then Choose a Folder to Watch dialogue box. 

 
Fig55: Folder selection window to save the file 

Choose a folder, then press the Select Folder button. 

You can see the folder in the Watch Folders window. 

 
Fig56: Watch folders window 

 

Now you can drag presets from the Preset Browser and drop them onto the folder.   

Exporting to Tape 

You can also export your project to DV videotape. However, before you do this, you must connect the 

device to your computer with a FireWire connection. 

Once it is connected, you are ready to begin. 

Turn your device on. Set it to VTR, VCR, or Play. 

Go to File>Export>Tape (DV/HDV). 

Set your options.   

Click Record for DV devices or Render and Record for HDV devices. 
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______________________________________________________________ 

Unit Summary 

In this unit, you have learnt about rendering which is an important component in video editing. It is the 

computer process combining the still images, video and audio clips and other visual elements into a single 

digital video frame.  

We have also learnt about exporting video and still images after assembling and editing clips in sequences 

to generate the final video. 

___________________________________________________________________________________________ 

Assignment 

1. What do you understand by rendering and how essential is it in the editing process? 

2. What are the different steps involved while exporting the final output to the tape using Adobe 

Premiere Pro? 

_________________________________________________________________________________________ 

Terminology 
 

EXPORT RANGE:   You can choose whether you want to export the entire sequence duration, or the 

work area defined in the sequence area.  
 

COMPRESSION:  A codec to compress the information for storage and transfer when exporting a 

video program. 
 

FRAME SIZE:  Set the dimensions for video frames you export in pixels. 
 

CG:  Computer generated graphics, a visual effect term used  by industries.  
 

SFX:  SFX, an abbreviation for Special Effects. 
 

 

================= 
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